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1 Introduction

1.1 Welcome

Natara Bonsai outliner is an organizational tool with many uses. Use Bonsai as a
task manager, organize your thoughts for a presentation, or keep important
information handy.

Bonsai is available as both a Windows and a Palm OS application.  Use it to outline
ideas, create checklists, or perform simple project management tasks. Bonsai
provides true one step outline synchronization between a Windows desktop and a
Palm OS handheld.

Key features:
· True one-step synchronization using HotSync technology
· Create simple outlines, to do lists or projects
· Multi-line in place editing of text
· Wide range of display options
· Drag to move or change indentation
· Sort on any attribute
· Filter based on multiple criteria
· Supports both a local and the Palm OS find command
· Color and high resolution support
· Support for icons with categories and keywords.
· Attach notes to items
· Link items to the built-in To Do, and date book databases and other outlines
· Assign contacts and keywords to items.
· Beam outlines to other Palm OS devices
· TealPrintÔ and PalmPrintÔ Palm OS print driver support

1.2 What's New

Changes in version 4.1.1

New on Desktop
· Print a single note.
· Support for multiple Views with initial filter and color settings.
· The user configuration (synchronization, categories, keywords, icons) is now stored in

an XML file.
· Desktop user can configure an icon file.
· Export option added to define the text used for a Custom value of zero.

New on Handheld
· New 5-way left-right options for zoom and marking tasks completed.
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· Added Zoom Off tool bar icon. The Zoom Out command has been changed to only
zoom out 1 level.

· Views can now have an initial filter and color setting.

Changes in version 4.0.3

New on Desktop
· Added menu item for toggle filter state Alt+T.
· Added shortcut for Outline Sort dialog (F8).
· Recognize additional Thought Manager PDB export format type for import.

Changes in version 4.0.1

New on Desktop and Handheld
· The results of a flat filter can be sorted.
· The sort column of a flat filter can be changed by clicking on the column header.
· A Next Action filter type has been added.
· The scope of a filter can be set so that all children of items that match a filter are

included.
· A custom numeric field has been added.
· Ability to filter for items that do not have keywords.
· Added option for completed item text color.

New on Handheld
· Option to retain current graffiti state when launching Bonsai.

New on Desktop
· Spell check (with check while you type in notes pane).
· Expand incomplete items by holding control key while clicking on expand to level

toolbar buttons.
· Click and drag to select multiple items using both index column and selection gutter.
· Rename outline command added to the Outline Manager.
· Save All command
· A plug-in for Google Desktop to index outline files.
· Context menu for outline tabs
· More flexible CSV import.
· Better keyboard navigation between columns.
· Import backup PDB's from ThoughtManager and BrainForest.
· Desktop can be installed and used without Palm Desktop / HotSync Manager.

Changes in version 3.3.5
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New on Handheld
· Added ability to selected from multiple storage card slots.

Changes in version 3.3.4

New on Desktop
· Added configuration for first day of the week.
· Ctrl+Del to delete the current word.
· Added option to include XSLT in XML export.

New on Handheld
· Added expand-collapse to 5-way up-down configuration.
· File in DayNotez options are now persisted.
· Option for confirmation prompt when deleting items with notes.

Changes in version 3.3.3

New on Desktop
· Added support to drag and drop text from other Windows applications.

Changes in version 3.3.2

New on Desktop
· New replacement options for priority text in export templates.
· Example MPX export template is included.
· Command added to insert a file link.

Changes in version 3.3.1

New on Desktop
· URL's are now color highlighted and can be clicked.
· Replace command.

New on Handheld
· Option added to disable the shading of the toolbar.

Changes in version 3.2.1

New on Desktop
· Icon support for categories and keywords (uses same icons as handheld).
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· Select Keywords from the Item menu.
· Link to other outlines from the Item menu.
· Submenu added to select current color scheme.
· Drop arrow for Undo toolbar button to display what actions will be undone.

New on Handheld
· Shading of toolbar added.

Changes in version 3.1.1

New on Desktop
· XML Export (Bonsai) & Import (Bonsai, OPML, Mind Map, Shadow)..
· Link with To Do keyboard shortcut.
· Added a menu item and keyboard shortcut to select all siblings.  When on root, selects

all items in the outline.
· Added a menu item and shortcuts to edit the active filter.
· Control-drag to duplicate a branch.
· Color for parent items that do not match active filter is configurable.
· Keyboard shortcuts added to set item type.
· The position of the notes splitter is saved with the outline.  When the outline is again

opened, the splitter position is restored.
· Outlines imported from a CSV are assigned the default colors and other attributes
· Keyword defaults for new items.
· Sort on keywords and contacts.
· A keyboard shortcut, dialog, and command line option to jump to a linked item using its

link tag number.
· Integration with Outlook and the Palm Desktop to jump to linked items in Bonsai

outlines.

New on Handheld
· Icon support for categories and keywords.
· Configurable named views with collapsible header.
· Jump back to Bonsai from link (both hack and OS 5 application).
· Icon column for Contact.
· Added the private outline attribute to list of columns that can be displayed.
· An alarm can be configured when adding a new event when linking to the calendar.
· Keyword defaults for new items.
· Sort on keywords and contacts.

Changes in version 3.0.3

New on Desktop
· Command line CSV import accepts a category parameter.
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· Drag and drop within the Outline Manager.

New on Handheld
· The number of times an outline is used is counted.  This usage counter can be displayed

on the view that lists outline names, and is available in the outline details dialog.
· The category of an outline received by beaming or manual installation is added to the

list of outline categories.

Changes in version 3.0.2

New on Desktop
· Added a new view to the Outline Manager.  Outlines can now be organized by folder.
· The Outline Manager now remembers the expand-collapse state.
· Multiple keywords can be selected from the keyword list at one time.
· Keywords can be assigned across multiple selected items.
· Added shortcut key to assign keywords to items
· Added shortcut key ctrl+1 .. ctrl+5 sets priority.
· Added shortcut key alt+1 .. alt+4 expands outline to level.

Changes in version 3.0.1

New on Desktop and Handheld
· A contact name can be associated with items in the outline.
· Keywords can be added to items in the outline.
· New icons for toolbars.
· Alternating background colors can be configured.
· Items in the outline can now be linked to an event in the date book. The links can be

created on the handheld (and show on the desktop).
· Separate color set for each style of coloring is maintained.
· Improvements to filtering; filter by text, multiple categories, and additional date

options.
· Auto to do link option for new items was added.
· More flexibility in numbering.

New on Desktop
· The UI can now be configured for either Windows XP or Office 2003 look and feel.
· Tabbed interface.
· An Outline Manager windows was added.  This dockable window shows the names of

outlines organized in a hierarchy.  Outline categories can be managed within this
window.

· Bonsai remembers what outlines were open and restores them when it is started again.
· Added Zoom support.
· Dates can be for multi-selected items.
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· Context menu improvements.
· Undo support was added for sorting.
· The number of items (and selection count) is shown in the status bar.
· Undo support added for changes to an outline's categories.  Items that used a deleted

category are now moved to unfiled.
· Column headers are now printed.
· A command line export can now run even if Bonsai is already running.
· The icon used for outline files is now unique from the Bonsai application outline for

easy recognition.  You may not see this change until Windows updates its icon cache.
· Added #FILTER_NAME#, #CONTACT#, #KEYWORDS# to the list of export

replacements.
· Command line import of a CSV file.

New on Handheld
· The name of the outline is shown as the title of the outline details dialog.
· The item text is used as the title for the details dialog.
· For the Treo 600, Option-select does performs command configured for Select.
· New menu item and shortcut to return to the view of outline names.

New in the conduit
· Filters are synchronized.
· Improved outline synchronization algorithm.

Changes in version 2.8.1

· Added support for the PalmOne Tungsten T3 portrait and landscape 320x480 screen
size.

· Added support for the Handspring Treo 600 5-way navigation buttons.
· Added additional option settings for 5-way navigation buttons.

Changes in version 2.7.1

· Added support for the Sony Clie UX50.
· Added a priority filter of 'has priority'.

Changes in version 2.6.1

· Support added for the AlphaSmart Dana wide screen.
· Added option to hide the entire branch if an item is filtered.
· Added option to show Simple items when filtering on status.
· Sort by Completion date.
· The install script has been rewritten to improve compatibility.
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1.2.1 Checking for Updated Version

Use the "Check for Update" command on the Help menu of the Bonsai Windows
application to see if a new version of Bonsai is available.

1.3 Installation

How to install Natara Bonsai.

Palm OS Application Only

Download and extract the distribution files for the Bonsai Palm OS application to a
temporary directory. Double-click on the file Bonsai.PRC to run the Palm Install Tool
or the Palm Quick Install to queue the application for installation to your handheld.
The Bonsai application will be installed during the next synchronization.

Windows Desktop Application Only

Download and extract the distribution files to a temporary directory. Run the
setup.exe (or run the self-extracting download) and an InstallShieldÔ application will
guide you through the installation process. When the setup completes, double-click
on the Bonsai icon on the Windows desktop to launch Bonsai.

Windows Desktop with Palm OS Applications

Follow the instructions for installing the Bonsai Windows applications. During the
setup you will be asked to identify the handhelds to install Bonsai on. Perform these
steps after installing to create and synchronize your first outline.

· Start Bonsai by double-clicking the Bonsai icon on your Windows desktop.
Bonsai opens a blank outline.

· Type in an outline.
· Save your outline using the Save command on the File Menu.  The name you

give the file will be used as the name of the outline on your Palm device.
· Respond 'Yes' when prompted if you want to synchronize this outline.
· Perform a synchronization to install the Bonsai application on your Palm OS

device.
· Perform a second synchronization.  The Bonsai conduit will be run since the

Bonsai application was found on your Palm device.
· Tap on the Bonsai icon on the applications screen.
· Tap on the outline name, and tap open to view your outline.

The license agreement allows you to evaluate Bonsai for 30 days before purchase.
A registration code is required to continue using Bonsai after 30 days of use.
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1.4 Requirements and Limitations

1.4.1 Requirements

Bonsai has the following requirements.

Windows Desktop Requirements
· Windows 98SE, Windows NT 4.0, Windows 2000 or XP.
· Approximately 15 MB of disk space.

Requirements for Synchronization
· HotSync Manager version 3.0 or greater
· The Back-2-Bonsai Palm Desktop add-in requires Palm Desktop version 4.1

or later.

Palm OS Device System Requirements
· Palm OS 4.0 or greater (Palm OS 5 recommended).
· Approximately 540 KB for the application.

1.4.2 Limitations

Bonsai has the following limitations.

Limitations
· Each item in the outline is limited to 1000 characters.
· The outline depth is limited to 30 levels.
· Notes attached to items are limited to 32 KB.
· Limit of 15 user defined category names for each outline.

Limitations for Palm OS handhelds
· Total number of outlines and each outline size is limited to available Palm

memory.
· File names used for outlines that are synchronized must be unique within the

first 28 characters.
· The global find command does not search outlines stored on a storage card.
· The Undo command on the handheld only acts on simple editing of text.

1.5 Purchase a License

You can purchase a license for Bonsai from the Natara website at
http://www.natara.com/bonsai/purchase.cfm.

After purchasing a Bonsai license, you will receive a registration number by email
(usually within the hour, but please allow up to 24 hours).  Follow the instructions in
the email to enter your registration number in the desktop application's registration

http://www.natara.com/BuyNow?Product=Bonsai4&Retailer=Natara&Version=4.1.2.2264&Days=-2&Pt=3
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number dialog.  The registration number will then be copied to your Palm device
during the next synchronization.

1.6 License Agreement

License Agreement

1. GRANT OF LICENSE.  Natara Software, Inc. ("Natara"), grants to you, the end user, a personal, nonexclusive license to use 
single copy of this software program, including any updates, additional modules, or additional software provided by Natara in
connection therewith (the "Software"), solely for your own use, and solely in accordance with the terms and conditions of this lice
agreement.  You may copy the Software into the memory of any computer, solely as necessary to use the Software in accordan
with this license agreement.

2. INSTALLATIONS AND USE.  Natara Bonsai is licensed to you in one of two potential configurations: (1) Single User License 
(2) Evaluation License.  You may install and use (in he manner provided) only those configuration(s) for which you have obtained
license. Licenses for Natara Bonsai are individual named user licenses. No license may be shared, in any capacity, by more tha
one individual end user.

(1) Single User License.  You may install and use a single copy of the Software on a single handheld device.  You may install th
software on up to two (2) computers that the handheld device synchronizes with.  You may access the Software from a hard disk
over a network, or by any other method; strictly in accordance with the terms hereof.  You may use each licensed copy of the
Software on up to two (2) computers and a single handheld device.

(2) Evaluation License.  You may use one copy of the Software on a single computer and handheld device, for a period not to
exceed thirty (30) days.  You are acquiring only the limited right to use a single copy of the Software for evaluation purposes. Yo
are not acquiring any rights to the Software itself.

3. COPYRIGHT AND COPIES.  The Software (including any copy thereof), is owned by Natara or its suppliers and is protected b
United States copyright and patent laws and international treaty provisions.  The Software copy is licensed, not sold to you, and 
are not an owner of any copy thereof.  You may either (a) make one copy of the Software solely for backup or archival purposes
(b) transfer the Software to a single hard disk provided you keep the original solely or backup or archival purposes.  You may no
otherwise copy the Software except as expressly authorized by applicable law, and you may not copy the written materials
accompanying the Software.  Natara hereby reserves all rights not explicitly granted in this software license agreement.

4. OTHER RESTRICTIONS.  You may not rent, lease or transfer the Software.  You may not reverse engineer, decompile or
disassemble the Software, except to the extent expressly authorized by applicable law.

5. LIMITED WARRANTY AND REMEDY.  Natara warrants the physical media (e.g. diskette(s) or CD-ROM), and the physical
documentation, to be free of defects in materials and workmanship for a period of 90 days from the original purchase date.  If Na
receives notification within this warranty period of any such defects and such notification is determined to be correct, Natara will,
its sole option and discretion, repair or replace the media or documentation, or provide you a full refund.  The foregoing is your s
and exclusive remedy and states Natara's and its suppliers' entire liability arising out of this warranty.  This limited warranty is vo
the damage or defect has resulted from accident, abuse or misapplication.
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6. NO OTHER WARRANTIES.  THE LIMITED WARRANTY ABOVE IS EXCLUSIVE AND IN LIEU OF ALL OTHER CONDITION
AND WARRANTIES FOR THE SOFTWARE AND DOCUMENTATION.  NATARA AND ITS SUPPLIERS MAKE NO OTHER
CONDITIONS OR WARRANTIES, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, AND EXPRESSLY DISCLAIM ALL
OTHER CONDITIONS AND WARRANTIES, INCLUDING BUT NOT LIMITED TO IMPLIED CONDITIONS OR WARRANTIES O
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT FOR THE SOFTWARE AND
DOCUMENTATION, TO THE FULLEST EXTENT PERMITTED BY APPLICABLE LAW.

7. LIMITED LIABILITY.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT AND UNDER NO
LEGAL THEORY SHALL NATARA OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY COSTS OF SUBSTITUTE PRODUCTS
OR FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE OR INDIRECT DAMAGES OF ANY KIND ARISING OU
OF THE LICENSE OF, USE OF, OR INABILITY TO USE ANY NATARA SOFTWARE OR DOCUMENTATION, EVEN IF NATAR
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO EVENT SHALL NATARA'S OR ITS SUPPLIERS'
LIABILITY EXCEED THE LICENSE FEE PAID BY YOU.  THIS LIMITATION OF LIABILITY AND RISKS IS REFLECTED IN THE
PRICE OF THE SOFTWARE LICENSE.

8. TERM.  This license is effective until terminated.    You may terminate it at any time by destroying the Software together with 
copies, modifications and merged portions in any form.  It will also terminate automatically upon your failure o comply with any te
or condition of this Agreement.  In the event of such termination, you agree to promptly destroy the Software together with all co
modifications and merged portions in any form.

9. MISCELLANEOUS. This is the entire Agreement between you and Natara, and supersedes any prior agreement, whether writ
or oral, relating to the subject matter of this Agreement.  This Agreement is governed by the laws of the State of Illinois, U.S.A.,
without reference to conflict of laws principles.  All disputes arising out of this Agreement shall be litigated or otherwise resolved
exclusively in the state of Illinois.  If any provision of this Agreement is ruled invalid, such invalidity shall not affect the validity of 
remaining portions of this Agreement.

1.7 Other Copyrights

This product contains Polar SpellChecker from Polar. Copyright © 1998-2001. All rights
reserved.

2 Outline Fundamentals

Items in the outline are arranged in a hierarchy.  Diamond symbols are used for
items that do not have child items.  Triangle symbols are used to indicate items that
have children items.  The triangles point to the right when the branch is collapsed.
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Bonsai on a handheld using the Palm OS.

Many of the commands operate on the current item.  The current item is the item that
contains the blinking insertion caret.

2.1 Item Attributes

Each item in the outline has a set of attributes.

Title
This is the text that is displayed as the outline content.

Notes
Additional text associated with the item. Displayed in a separate pane or dialog.

Type
Each item in the outline can be one of 3 types; Simple, To Do and Task.

Create Date
The time the item was first added to the outline. This attribute cannot be modified.

Start Date
The date when a To Do or Task should start

Due Date
The date when a To Do or Task should be done.

Completed Date
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The date a To Do or Task was completed.

Last Modified Date
Bonsai records the last time any of the item's attributes were modified.

Percent Complete
An indication of the progress of a To Do or Task. The value for a To Do can only
be either 0% or 100%. The percent complete of a Task can be anywhere from 0%
to 100%.

Priority
The importance of the item. The priority is in a range of 1 to 5, with 1 being the
most important. The priority can also be set to a value of None.

Category
This attribute can be used to group like items. Only a single category can be
assigned to each item.

Keywords
Also used to group like items. Multiple keywords can be assigned to each item. In
contrast to categories a much larger number of keywords can be defined.

Contact
This attribute can be used to associate a person with an item. However it can be
used for other purposes since the value is not restricted to an external source.

Link
The item can be linked to other Bonsai outlines, or when used on a handheld
computer it can be linked with a To Do or Calendar entry.

Custom
A general purpose numeric value. This is a signed value with 2 decimal places.
The label assigned to this attribute can be set in the outline preferences. One
possible use of this value is to calculate project cost.

Parent of Next Action Items
This yes/no attribute is used in conjunction with a filter option to display the single
child item that should be accomplished next.

Unique Identifier
Bonsai assigns a unique number to each item in the outline. This value is used for
synchronization with handheld computers and is not normally visible.
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2.1.1 Item Types

Each item in the outline has a type. Bonsai supports 3 types: Simple, To Do, and
Task.

· Simple items do not have dates or completion status information.
· To Do's have dates (start, due, and completed), and a done/not done status.
· Tasks have dates and a percent complete status.

An outline can have items of mixed types.  When the preference to show completion
status is enabled, a different symbol is shown for each item type.
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2.2 Outline Attributes
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2.2.1 Filters

Filters are used to restrict what items in the outline are displayed to highlight some
attribute. For example, completed tasks can be hidden so that the tasks that remain
to be done are seen.

Each filter is given a name so that it can be selected from a list.

Filter Options
· Flat display - When this option is checked the items that match the filter are

displayed as a flat list. When the option is unchecked the outline hierarchy is
maintained.

· Scope - This option can be used to restrict what items are examined. The scope
option takes affect at the level specified. The default is to apply the filter to all
items in the outline.

· Apply filter to every item in outline - Each item in the outline is
examined to see if it matches the filter.

· Hide entire branch when a parent does not match filter - If a parent
item does not match the filter criteria then none of its child items are
examined or displayed.

· Include entire branch when parent matches filter - If a parent item
matches the filter then all of its child items are included without
considering the filter.

· Next Action - This option works in conjunction with the
"Parent of Next Action Items" attribute that is applied to parent items in the
outline. When this option is checked Bonsai will examine all the child items of
such a parent and select the first incomplete item (also know as the Next Action).
If that item does not match the other attributes of the filter then none of the
children are displayed.

· Reverse - When this option is checked Bonsai will reverse the result of checking
the filter attributes against an item.

Select one or more of the following criteria. When an item in the outline is compared
against the criteria it must match ALL the criteria to be shown.

Filter Criteria
· Status - Select the status of a To Do or Task. For example is the To Do

completed or incomplete.
· Type - Select what type of items should be included. For example only show To

Do's.
· Priority - Select what priorities to display. For example only display the highest

priority tasks (priority is 1).
· Link - Display items that are linked to the calendar or To Do's.
· Text - Does the outline item contain the text string.
· Dates - Display items that have certain dates.
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· Contact - Display items that have a certain contact name.
· Categories - Display items with given categories. One or more categories can be

included.
· Keywords - Display items with given keywords. There are options for matching

all, any, or none of the keywords.

The Next Week, Current Week and Last Week date ranges for filters are based on
calendar weeks.

2.2.2 Colors

The default color for outline text is black. There are also several color schemes that
can be used to color the outline text. Switching between the color schemes can be
performed as needed.

Category
Assign a color to each category

Priority
Assign colors to priorities to highlight important tasks

Outline Level
Assigns color for each level in the outline

Due Date
Highlight tasks that are coming due with color.

A color can also be configured for completed items.

2.2.3 Views

Bonsai provides multiple named views for each outline. Each view describes what
columns are displayed, if a filter should be enabled, and what color scheme should
be used.

There is always at least one default view for each outline.

Views are not synchronized since the resolution differences between handhelds and
desktop machines make them more specific to one platform or the other.

2.2.4 Categories

Each outline has its own set of categories that can be applied to the outline items.
Categories are useful for grouping like items. A filter can then be used to show only
the items within a given category.
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There is one special category named "Unfiled" in each outline that cannot be
renamed or deleted.

There are limitations to the number of categories and category name length for
outlines that are synchronized with a Palm OS handheld. To retain compatibility only
15 user defined Categories can be created, and each category name must be 15
characters or less.

2.2.5 Icons for Category and Keywords

Bonsai has support for displaying icons for categories and keywords.  The category
and keyword icons can be shown in outline view columns.  Category icons are
configured on the Category tab of the Preferences dialog on the desktop and the
Icon tab of the Preferences dialog of the handheld. Keyword icons are configured
from the keywords dialog.

Bonsai supports the defacto icon standard established by Agendus (formerly Action
Names) and now supported by several other Palm OS applications, such as DateBk
5. Free and commercial icon sets are available online from many download sites.
Here is an example of the Bonsai dialog used to select an icon from the icon set.
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The Palm OS application Icon Manager (authored by Christopher Antos) can be
used to create a private set of icons. At the time of this Bonsai release, Icon
Manager version 1.6 is a free application available from most download sites. Bonsai
can either share the icon set used by other applications or use a private set of icons.
Create an icon database named "BonsaiIcons" if you want a private set of icons. If
this private icon database does not exist, Bonsai will use the default set of icons.
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During synchronization the Bonsai conduit determines what icon set is being used by
Bonsai on the handheld. The name of the icon set is saved by the conduit for use by
the Bonsai desktop application. When the Bonsai desktop application is run, it will
load the icon set from the HotSync Manager backup directory. Your icons must be
backed up to the desktop in order to be used by the Bonsai desktop application.

Note:
Bonsai references icons by their resource id.  This allows icons to be
moved within icon sets without affecting existing outlines.

Note:
By convention, icons should be given resource id's in the range from 0 to
8999.

2.3 Actions
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2.3.1 Add Items to the Outline

Bonsai is designed for quick data entry on both the handheld and your Windows
desktop machine.  As you compose your outline and finish one item, type (or graffiti)
a return to start the next item.  The new item will be inserted at a level that is
appropriate for the current state of the outline.

The handheld application has 2 toolbar icons for inserting new items.  One inserts a
new sibling item, and the other a new child item.  The items are inserted based on
the current location of the input caret.

On the desktop, Shift-Enter will give priority to inserting the new item one level below
the current item. On the Palm device, the New Child menu command will create a
new child item under the current item.

There is a preference that controls the type (Simple, To Do, Task) given to new
items.  When starting a new outline, it is best to configure this preference for the
most common type of item that will be added to the outline.

If you paste text from another application that is composed of several lines, Bonsai
will create an item for each line of text.

Note:
If an active filter will hide a new item, the filter is cleared so the new
item will be shown.

2.3.2 Expanding and Collapsing

Tap on the triangle symbols to expand and collapse that branch of the outline.  There
are also menu commands that will expand or collapse the current item, or the entire
tree.  Tap on the outline icon to display a pop up menu of expand levels.
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Bonsai saves the expand-collapse state of the outline so that it will open to the same
state the next time it is viewed.

2.3.3 Moving Items Up and Down

When dragging a branch, the highlighting of an item indicates that the branch would
be dropped as the last child of that item, and an insertion bar indicates that the item
will be dropped as a sibling.  When dropped as a sibling; if the item above the
insertion bar is a parent of the item below, the branch will be dropped as the sibling
of the item below the bar (which is also the first child of the parent above the bar).
Otherwise, it is dropped as the sibling of the item above the insertion bar.

When dragging, you can scroll the view to an off screen location by positioning you
stylus at the top (title area) of bottom (button area) of the view.  The desktop
application also supports Alt-Shift-Up Arrow and Alt-Shift-Down Arrow to move items
up and down within their siblings.\

Holding down the Control key when dropping a branch will perform a copy operation,
instead of a move. A plus sign is displayed with the drag cursor during a drag copy.

2.3.4 Indenting Items

Tab and Shift-Tab can be used to quickly change the indentation of an item.  This is
the quickest way to change indentation when using a keyboard.  The desktop
application also supports Alt-Shift-Left Arrow and Alt-Shift-Right Arrow to change the
indentation.
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When using a stylus or mouse, tap/click and hold as with vertical dragging, but shift
the item in or out.  With the Palm application, the next-field, previous-field graffiti
strokes also change the indentation of an item.

The Windows application uses a vertical line to show the indentation level.  The
Palm OS application will redraw the item as it is shifted.

On the desktop, a vertical line is drawn to indicate the indentation level for the drag.
A box is drawn on the line to indicate the branch being indented. In the example
below, 2.B will be indented and become 2.A.3.

2.3.5 Managing the Hierarchy

Both the Palm OS and the Windows applications support the management of the
hierarchy through dragging and cut-paste operations.  To drag a branch, tap and



Outline Fundamentals 29

© 1999-2007 Natara Software, Inc.

hold on the expand symbol or diamond and drag the items. During a drag on with
Palm OS application, a box is drawn around the branch being moved.

When using cut-paste, tap on the item's text so the insertion caret is on the item to
be moved.  Then use the menu Cut Branch or Copy Branch commands.

On the desktop, a line is drawn to show where in the outline the item will be moved.
A small box is drawn on the line to indicate the level at which the branch will be
inserted.

In the above example, the branch will be inserted as a child of 2.A.
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3 Bonsai Outliner for Windows

This topic describes the Bonsai outliner application for Windows.

3.1 Starting Bonsai

Double-click an existing outline file, or select Bonsai from the Natara Software group
on the Windows Start menu.

The first time Bonsai is run is will start an empty outline. After the first time, Bonsai
will restore the outlines that were open the last time it was run.  Bonsai can have
several outlines open at once.

Bonsai can also be run from a command line to import or export an outline.

3.2 Desktop Main View

This is the view of an outline on the desktop.  The view of the outline is customizable
using the Preferences dialog.



Bonsai Outliner for Windows 31

© 1999-2007 Natara Software, Inc.

By clicking in the selection gutter you can select multiple items to operate on.

Right-click on the column header to select columns for display.

When the mouse moves over the link or note columns information about the link or
note is shown in a pop up window.

An asterisk is appended to the outline name in the title bar when the outline has
been modified.

3.3 Selecting Multiple Items

The desktop application supports selecting multiple items.  Click on the selection
gutter to select an item.  The item will be highlighted.  Use Ctrl-Click and Shift-Click
to expand the selection.  Operations can then be done on all the selected items.
Use the commands on the menus, or right-click for context menus.

You can also select all the siblings of the current item using the command on the Edit
menu or Alt+A.
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Four items in the outline have been selected in the example above.  The category of
all four items could be set by selecting a new category from the Item menu.

3.4 Zoom in on a Branch

Bonsai has the ability to zoom in on a branch.  Only the children of the single branch
are shown. The Zoom Out command returns to the original view.

In this example notice how the tab is updated with the name of the zoomed branch.
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3.5 Item Details

Besides its title each item has an additional set of attributes.  When not displayed on
the outline view the attributes can be viewed and set on the details dialog. Alt-Enter
displays the details dialog for the current item. The following topics cover each tab of
the details dialog.

3.5.1 General Tab

The General tab contains the item type, category, and priority and completion status.
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The information shown on the General tab is dependent on the item's type. Simple
items do not have a completion status.

3.5.1.1 Type

Each item in an outline is one of 3 types: simple, to do, and task.  The type assigned
to an item when it is added to the outline is controlled by a preference.  The type can
then be changed from the details view.

A Simple item can be changed to either a To Do or a Task by tapping (or right click)
on the status icon and selecting the type from the pop up menu.  With the desktop
application, right click on the completion status to display the item type menu.

3.5.1.2 Status

Items of type To Do and Task have a completion status.  To do's are either done, or
not done.  Tasks have a completion status between 0% and 100%.  The status can
be set directly on the details dialog.  The hard scroll buttons will change the percent
complete of a task by 10% for each press.
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The status of an item can also be set from the outline view when the completion
status is shown (a preference setting).  Tap (or left click) on the progress bar and
drag left and right to change the percent complete.

On both the desktop and Palm device, command and shortcuts are provided that
toggle the completion status

When you change the completion status of an item, the completion status of its
parent items is recalculated.  A preference setting is available to disable this
behavior.

3.5.1.3 Priority

Each item has a priority from 1 to 5, or no assigned priority.  Priority 1 is considered
the most important.  You can filter the outline with a priority.  The priority of an item
can be set from the outline view when the priority is shown (a preference setting).

The priority assigned to new items can be set in the preferences.

3.5.1.4 Category

Categories provide a customizable attribute that can be used as desired.  Each item
in the outline can be assigned to a category, or left unfiled.

The outline can be filtered on category.  For example, you could use the categories
with a To Do list to indicate the best time of day to perform the work.  You could then
filter your To Do list on time of day.

Note:
There is a 15 user-defined category limit for compatibility with
handhelds using the Palm OS.

3.5.2 Dates Tab

The Dates tab has the dates for items with a type of To Do or Task.
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The dates of parent items can not be modified if the option to roll up dates is
configured.

3.5.2.1 Dates

Items of type To Do and Task also have a Start, Due and Completion date.  When a
To Do is checked completed, or a Task is marked 100%, the completion date is set
to the current date.  The completion date can also be manually set to another date.

Besides the ability to select a date from the calendar, the context menu has several
quick dates.  The entries on the menu are specific to the start, due, and completion
date uses.

When you change the date of an item, the dates of its parent items are recalculated.
A preference setting is available to disable this behavior.

3.5.3 Links Tab

An item can be linked to either another Bonsai outline, an event in the date book, or
a standard To Do. Links can be set in the details dialog of an item.

An item can also be associated with a contact name.  Bonsai will provide a drop list
of contact names already in use in the outline.  However, you can put any text in this
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field.

One or more keywords can be assigned to the item.  Keywords are selected from the
keyword dialog.

3.5.3.1 To Do Links

To Do links are available in outlines synchronized with a handheld.

When an item is linked a new To Do is created in the built-in To Do database using
the attributes of the item (Name, Note, Priority, Due Date, Completion Status,
Category).  The To Do is created by the conduit during synchronization.

If there is a category in the standard To Do database that matches the category of
the item in the outline, the linked to do will assigned that category.  Otherwise, the to
do will be assigned the unfiled category.
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Note: Changes made on the desktop to an item linked with a To
Do require 2 synchronizations before they appear in the desktop PIM
application.  On the first synchronization the changes are propagated to
the handheld To Do database.  On the second synchronization the
changes are propagated to the desktop PIM application by the PIM
HotSync Manager conduits.

3.5.3.2 Outline Links

Linking an item to another outline is done in the details dialog.  The name of the
linked outline will be displayed below the link selection.  Tapping on the outline link
icon (the tree) will jump to the linked outline.
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The link can be thought of as a master project to subproject link.  The link points to
another outline, and not to an item.  Changing the selection will break the link to the
other outline.

3.5.3.3 Keywords

One or more keywords can be assigned to an item. Keywords are useful when
filtering an outline. Icons can be assigned to keywords.
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You can assigned multiple keywords to an item on the desktop in one operation.
Click on the Add button to display the Select Keywords dialog. Select each keyword
to be added to the item and click OK.
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By default the keywords will be appended to the item's existing keywords. By
checking the replace option, the existing keywords will be removed before added the
new keywords.

You can also assigned keywords to multiple items in an outline in one operation.
Select all the items using the selection gutter and select Keywords from the Item
menu.

3.5.4 Text

An alternative way of editing the outline text is the Text tab of the details dialog.



Natara Bonsai User Manual42

© 1999-2007 Natara Software, Inc.

3.5.5 Notes

Tap on the note button to display and edit the note.  Each item can have a note up to
32K.
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A note icon can be displayed on the outline view to show what items have notes.
The note for the current item (where the caret is displayed) is shown in the window.
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3.6 Keywords

Bonsai maintains a single list of keywords that is shared by all outlines. When adding
keywords to items in an outline this list is displayed.  Keywords are assigned to
categories for grouping.

The keyword list is global to all outlines.  Keywords are inserted into outlines as text,
and not as references to the global keyword list.  Changes you make to the global
keyword list are not reflected in the outlines.

Icons can be assigned to the keywords. The icons can then be displayed in the
outline instead of the keyword text.

Keywords for items are shown on the Links tab of the details dialog.
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When all keywords are shown (see desktop example above), the category is
appended to the keyword for display. When a category is selected, as with the
handheld example, the category is not appended to the keyword.

Note:
During synchronization the most recent set of keywords (desktop or
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handheld) is copied over the other set.  For this reason, perform
keyword maintenance on one side between each synchronization.

3.7 Filter the View

Bonsai supports the ability to filter the items that are displayed.  To access the dialog
to create new filters or edit existing filters; tap the filter drop list in the upper-right of
the handheld screen, or click on the edit filter icon on the desktop application.

Several attributes can be filtered at one time.  Only items that match all the selected
attributes will be displayed.  For example, it is possible to filter for priority 1
incomplete items from the business category.

An existing filter can be enabled by selecting it from the filter drop-list.

Note: The current filter is automatically disabled if none of the items in the
outline match the filter.

3.7.1 Filter List

Select a filter to use, or create and edit filters from this dialog.

If you have create a set of filters in another outline that you would like to reuse, use
the Import option to copy them into this outline.

Select Use Filter to activate the selected filter.
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3.7.2 Filter Definition

The filter definition is divided onto several tabs.

3.7.2.1 General

The first tab contains the filter name and several filter criteria.
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The following filter attributes are on this tab.

Filter Attribute Description
Name Assign a name to the filter to describe its action
Status Filter to do's and tasks based on the completion

status.
Type Filter on item type; Simple, To Do, and Task.
Priority A number of options to filter on priority.
Link Filter based on whether the item is linked or not.
Text A string to search for.  Check the Also search notes

option to search for the string in notes.

Attribute When checked  only these items are included

3.7.2.2 Options

This tab contains options that affect the overall filter results.
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The following filter attributes are on this tab.

Filter Attribute Description
Next Action Parents When the "Limit view..." option is selected Bonsai will

select a single child item to display for parents with
the Parent of Next Action Items attribute. The order
used for ranking the children can be selected here.

Flat When this option is checked the results of the filter
are displayed as a flat list.

Scope By default the filter is applied to all items in the
outline. There are two options for limiting the filters
use.

Reverse Filter Action When this option is checked Bonsai will reverse the
results of checking the filter against a single item.

Attribute When checked  only these items are included

3.7.2.3 Dates

This tab contains date and contact filtering options.
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3.7.2.4 Category

This tab contains category filtering options. The filter will only include items whose
category is checked.
Bonsai will not let you define a filter without at least one category checked.



Bonsai Outliner for Windows 51

© 1999-2007 Natara Software, Inc.

3.7.2.5 Keywords

This tab contains keyword filtering options. Since you can include more than one
keyword in the filter, there is a set of  options that affects how the keywords are
matched.
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3.8 Preferences

The preferences dialog is available from the Outline menu.  Note that each outline
has its own set of preferences.  Be sure to have the correct outline open when you
modify the preferences.

The initial value for the preferences is taken from a set of defaults.  The section
following this describes how to change those default preferences.  The preferences
are grouped onto tabs.

3.8.1 General

This tab has general display and numbering options.
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3.8.2 Calculated

This tab has options that control the calculation of parent values from children. When
the option is checked the value of the parent will be calculated from its children.
There are three options.

Completion Status
Check this option to calculate the percent complete or check box status from the
children items.

Dates
Check this option to calculate the Start, Due and Completion dates from the children
items. The start date of  the parent will be the earliest child date. The due date and
completion date of the parent will be the latest date of the children.

Custom Numeric Field
Check this option to calculate the parent's custom numeric value from the children
items. There are several options for the calculation.



Natara Bonsai User Manual54

© 1999-2007 Natara Software, Inc.

3.8.3 New Items

This tab contains options for new items.
For details on the options, see the New Items tab of the handheld preferences dialog

3.8.4 Categories

Edit the categories of an outline on this tab. Click the Icon button to select the icon
for the category using the Select Icon dialog.
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3.8.5 Views

Use this preference page to define views. Each view has its own set of columns to
be displayed, and optionally a filter to enable and a color scheme to use.

The columns can then be arranged and sized by dragging them in the outline
window.
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3.8.6 Colors

This tab is used to define a coloring scheme for an outline.  The "Color outline by"
selector has a list of several attributes.  They include; Category, Priority, Outline
Level, and Due Date.  Tap on the color box to display the color selection dialog.

Bonsai will remember a color scheme for each color outline by selection.

3.9 New Outline Defaults

Each outline has its own preference settings that determine how it looks and
behaves.  Once an outline is created, these settings can be modified without
affecting other outlines.

Bonsai has a set of initial preferences that are given to all new outlines.  A separate
set of defaults is available on both the Palm device and the desktop.

Use the New Outline Defaults command on the View menu to display the default
settings for new outlines.
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3.10 Settings

The Settings dialog has 6 tabs;

· General
· Colors
· Font
· Export
· Printing
· Synchronization

3.10.1 General

This is the general tab of the settings dialog.
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Setting Description

Enter splits item text When unchecked, a return graffiti stroke or enter key will start a
new item without changing the item where the caret is placed.
When checked, the title of the current item is split at the caret
location to create the new item.  This operation is similar to a word
processor.

Sort No Date to end of list Controls how the 'No Date' value is sorted in relation to other dates.

Show Simple items when
filtering on status.

Normally, a simple item will not match a filter that uses an item
status since it does not have a status. Check this option to cause
Simple items to match any status filter state.

Show notes on right Controls whether the notes pane is shown on the bottom or the
right of the window

Reapply filter while editing When checked, causes Bonsai to be very aggressive with an active
filter.  As an item is modified, it will disappear immediately if it fails
to match the filter.

Use MS Office 2003 look and
feel

Bonsai supports 2 styles; MS Office 2003 and XP.

Outline tabs When checked, Bonsai will display tabs for all the open outlines.

Large toolbars Check this option to use a larger set of toolbar icons.  This is useful
on some screen resolutions.

Show tool tips for icon
columns

When checked Bonsai will display a tip pop up when the mouse is
moved over a category or keyword icon.

Week starts on This setting affects filter operation for options that deal with end of
week, or a week range. It also affects the display of month calendar
dialogs.

Append space after inserted
date/time

When checked Bonsai will insert a trailing space when using the
insert date or time commands.

Icons Displays the name of the icon file for the current user. The icon
resource file for Palm OS users is determined by the Bonsai
conduit during synchronization and cannot be changed. The
desktop only user can edit the icon file name.

3.10.2 Colors

This tab has the settings for several colors used in the outlines.
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3.10.3 Font

This is the font tab of the settings dialog.

3.10.4 Export

The export tab contains options used during an export operation.
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Setting Description

Include these fields in the
exported file

Check the attributes that should be included in the export.  These
options only effect the standard export command, and do not effect
template exports.

Include this outline level and
above

To restrict the amount of details included in the export, select the
lowest level to export here.

Apply current filter to export When checked, only items that pass the current filter are exported.

Include DTD When checked, a reference to the Bonsai data type definition file
will be included in the exported XML file.  This is only applicable to
the fixed XML export format.

Include XSLT reference When checked, a reference to an XSLT file is included in the
exported XML file. This is only applicable to the fixed XML export
format.

3.10.5 Printing

This is the printing tab of the settings dialog.
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Setting Description

Include Notes Check this option to include the notes into the printed output.

Print in Black & White Some print drivers do not properly handle the color bitmaps used by
Bonsai for icons.  If this is the case with your printer, check this
option.

Only print the Outline column By default, Bonsai prints the outline as it appears on your display.  If
you only want to print the outline itself, and none of the other
displayed columns (dates, note icon, link icon, etc), then check this
option.

Include page numbers Check this option to include the page number at the bottom of each
printed page.

Include filter name Check this option to include the filter name in the footer of each
page.

3.10.6 Synchronization

There are several other miscellaneous options on the Synchronization tab of the
Settings dialog.
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Setting Description

Show Progress During
Synchronization

When this option is checked, the Bonsai conduit displays a
dialog during synchronization that shows what step is being
preformed.

Always check handheld To Do
database for changes

When this option is checked, the Bonsai conduit will
compare the standard handheld To Do database against
any outlines that contain To Do links even if the outline has
not been modified on the handheld or desktop.  If there are
a large number of outlines that contain To Do links, this can
slow down the synchronization.

Logging during synchronization This setting determines the amount of information written to
the HotSync Manager log file on the desktop.

Post synchronization command A command line in this field will be executed after the
Bonsai conduit completed synchronization.  The command
line should include a full path to the program to be
executed.

3.11 Spell Checker
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3.11.1 Spell Checker Options

This dialog is used to configure the Spell Checker. The dialog is accessed from the
View menu.

Bonsai is installed with the US English dictionary. To download other dictionaries
select Dictionaries from the Help menu. Place the downloaded dictionaries in the
Bonsai installation folder.

Note: The Check spelling as you type feature is only available in
the Notes pane and Note and Text tabs of the Item Details
dialog.

3.11.2 Auto-Correct Options

This dialog is used to configure the Auto-Correct features.
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Note: The Replace text as you type feature is only available in
the Notes pane and Note and Text tabs of the Item Details
dialog.

3.12 Toolbars and Shortcuts

3.12.1 Toolbars

There are several toolbars on the desktop application.  The toolbars can be shown
on hidden using the View Toolbars menu.

The contents of each toolbar include;

Standard Toolbar
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· New outline
· Open outline
· Save outline
· Save all open outlines
· Close all outlines
· Display Bonsai Settings dialog
· Change current HotSync User
· Display Outline Preferences dialog
· Print the outline
· Print Preview
· Display the user manual

Edit Toolbar

· Cut highlighted text
· Copy highlighted text
· Paste text
· Undo, with drop arrow of undo actions
· Insert date
· Insert time

Outline Toolbar

· Display Details dialog for current item
· Find
· Enable last used filter or disable current filter
· Display filter dialog
· Sort
· Outdent
· Indent
· Indent branch
· Move branch up (before previous sibling)
· Move branch down (after next sibling)
· Cut branch
· Copy branch
· Paste branch
· Delete branch
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Expand / Collapse Toolbar

· Expand current branch
· Collapse current branch
· Expand entire branch
· Collapse entire outline
· Collapse to level 2 items
· Collapse to level 3 items
· Collapse to level 4 items
· Expand entire outline
· Zoom in on current branch
· Zoom out

View Toolbar

The view toolbar displays the currently active view and has a drop list to select
another view.
· Display the View tab of the Outline Properties dialog.

Filter Toolbar

The filter toolbar displays the currently active filter and has a drop list to select a
filter.
· Enable last used filter or disable current filter
· Display filter dialog

Dates Toolbar

The dates toolbar displays the dates for the current item. There is an icon next to
each date for clearing that date.
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3.12.2 Shortcuts

The desktop keyboard shortcuts for Bonsai are as follows.

Delete Delete selected text, or character after cursor.
End Move cursor to the end of the item title.
Enter Insert an item into the outline.
Home Move cursor to the start of the item title.
Keypad '+' Expand the current branch.
Keypad '-' Collapse the current branch.
Tab Indent the current item.
F1 Display help.
F3 Open the Find dialog.
F5 Toggle the completion state of the current item.
F6 Switch between outline and notes pane.
F7 Spell check
F8 Sort
F9 Insert a file link.
F10 Display outline properties dialog.
F11 Hide and show the item selection gutter.

Shift + Delete Cut the selected text to the clipboard.
Shift + End Expand selection to end of item.
Shift + Enter Insert an item into the outline as a child of the current

item.
Shift + Home Expand selection to the beginning of the item.
Shift + Insert Paste the text from the clipboard into the current item.
Shift + Keypad '+' Expand all branches.
Shift + Keypad '-' Collapse all branches.
Shift + Left Expand selection to include previous character.
Shift + Right Expand selection to include next character.
Shift + Tab Outdent the current item.

Ctrl + 0 Set priority of item to None.
Ctrl + 1 .. 5 Set priority of item from 1 to 5.
Ctrl + A Select the entire title of the current item.
Ctrl + B Cut the current branch.
Ctrl + C Copy selected text to the clipboard.
Ctrl + D Insert current date.
Ctrl + E Remove keywords from current item.
Ctrl + F Open find dialog.
Ctrl + G Find again.
Ctrl + I Set item type to To Do.
Ctrl + J Jump to linked outline.
Ctrl + K Set item type to Task.
Ctrl + L Link item with To Do.
Ctrl + M Set item type to Simple.
Ctrl + N Start a new outline.
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Ctrl + O Display the dialog to open an existing outline.
Ctrl + P Print the outline.
Ctrl + R Copy the current branch to the clipboard.
Ctrl + S Save the outline.
Ctrl + T Insert the current time.
Ctrl + U Display the Replace dialog to find and replace text.
Ctrl + V Paste the text from the clipboard into the current item.
Ctrl + W Close the outline.
Ctrl + X Cut the selected text.
Ctrl + Y Paste the branch from the clipboard after the current item.
Ctrl + Z Undo the previous action.
Ctrl + Keypad '+' Fully expand the current branch.
Ctrl + Enter Insert a line break in the outline title at the current cursor

position.
Ctrl + Backspace Delete the previous word.
Ctrl + Delete Delete the current word.
Ctrl + Down Move the current branch after its next sibling.
Ctrl + End Move cursor to end of outline.
Ctrl + Home Move cursor to top of outline.
Ctrl + Insert Copy selected text to the clipboard
Ctrl + Left Move cursor to previous word.
Ctrl + Right Move cursor to next work.
Ctrl + Tab Switch to next outline.
Ctrl + Up Move the current branch before its previous sibling.
Ctrl + F4 Close current outline.
Ctrl + F7 Spell check current item or current note.

Ctrl + Shift + L Unlink item
Ctrl + Shift + S Save All
Ctrl + Shift + Right Expand selection to include next work.
Ctrl + Shift + Left Expand selection to include previous word.

Alt + 1 Collapse the entire outline.
Alt + 2 Expand outline to second level.
Alt + 3 Expand outline to third level.
Alt + 4 Expand outline to fourth level.
Alt + A Select all siblings of current item.
Alt + C Cycle through views
Alt + D Delete the current branch.
Alt + E Display the Edit menu.
Alt + F Display the File menu.
Alt + H Display the Help menu.
Alt + I Display the Item menu.
Alt + J Jump to the outline item using a link tag number.
Alt + Shift + J Display the Jump to Link dialog.
Alt + K Display the dialog to modify keywords.
Alt + L Display the list of global Keywords.
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Alt + M Toggle the display the Outline Manager window.
Alt + N Toggle the display of outline numbers.
Alt + O Display the Outline menu.
Alt + P Display the outline Preferences dialog.
Alt + R Edit the active filter.
Alt + S Display the dialog that lists filter names.
Alt + T Toggle current filter state.
Alt + V Display the View menu.
Alt + W Display the Window menu.
Alt + X Toggle the item's Parent of Next Action attribute.
Alt + Y Zoom out.
Alt + Z Zoom in.
Alt + Backspace Undo the previous action.
Alt + Shift + Down Move the current branch after its next sibling.
Alt + Enter Display the properties of the current item.
Alt + Left Move focus to the column to the left.
Alt + Ctrl + Left Collapse the current branch.
Alt + Shift + Left Outdent the current branch.
Alt + Right Move focus to the column to the right.
Alt + Ctrl + Right Expand the current branch.
Alt + Shift + Right Indent the current branch.
Alt + Shift + Up Move the current branch before its previous sibling.
Alt + F4 Exit Bonsai.

3.12.3 Status bar

The status bar on the Bonsai desktop application displays several items of interest.

· The current HotSync User (used during synchronization configuration)
· The number of items in the current outline, and how many are selected.
· The synchronization setting of the current outline.

3.13 Printing

The print command on the desktop will print the outline as shown.  The printed
output will always word wrap long outline text, even if word wrap is turned off.  You
can expand, collapse and filter the outline to print the level of detail required.

The notes can be included in the printed output by selecting an option on the Printing
tab of the Settings dialog.
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Note: Export templates provide a way to customize printed output.

3.13.1 Print Single Note

A single note can be printed when the cursor is in the note pane.

3.13.2 From an Export Template

The Template Print command on the File menu is used to print an outline using one
of the custom Export Templates.  The submenu lists all the available templates.
When you select a template from this menu, the outline is exported to a temporary
file, and then printed.  The printing is performed by the application that handles the
file type of the exported file.  For example, if the outline is exported to an HTML file,
Windows will direct the print request to your browser.

3.14 Outline Manager

The Outline Manager window is used on the desktop to organize and access your
outlines.  The outlines listed are for the current HotSync User shown on the
status bar.  Use the Select User command on the File menu to select a different
user.
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The Outline Manager has 3 views. Right-click and select View to select between;
· Grouped by outline category.
· Grouped by outline status of; synchronize, desktop, or missing.
· Grouped by the desktop folder.
· As a flat list of outlines.

The outline names are shown with one of 3 icons;

The outline is configured to synchronize with the handheld.

The outline does not synchronize with the handheld.

The outline is known to Bonsai but is missing from the desktop
machine.

Double-click on an outline to open it.  Left-click and control left-click to select
outlines. Operations are available through the context menu by right-clicking.
Operations available include;

· Open the selected outlines.
· Toggle the synchronization setting of the selected outlines.
· Set the category.
· Move outlines to another directory.
· Delete outlines.
· Change the Outline Manager view.
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3.15 Grouping Outlines

Bonsai allows you to create outline files in the directory of your choice.  You can
group outlines by placing them in subdirectories with your other related documents.
When working with the Bonsai desktop application, the Outline Manager window
provides a view of your outlines.

If you need to move an outline from one directory to another, use the Move
command in the Outline Manager.

3.16 Command Line

Summary of the Bonsai Windows command line options.

no command line Bonsai displays the outlines that were open when it was
last used.

<outline name> Bonsai displays the named outline, and the outlines that
were open when it was last used.

/export Bonsai exports an outline using an export template. The
user interface is not displayed.

/xmlexport Bonsai exports an outline in an XML format. The user
interface is not displayed.
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/import Bonsai imports information from either a CSV or XML file
and creates an outline.  The user interface is not
displayed.

/linktag:<number> Bonsai displays the outline that contains the linked item
and positions the cursor to the item.

/uid:<number> An outline name must follow this option. Bonsai will display
the outline and position the cursor to the item with the
given Unique Id.

3.17 How Do I ... ?

How to perform common activities.

3.17.1 Create a New Outline

From within the Bonsai application, click on the new outline icon, or use the New
command on the File menu.

When you start the Bonsai application, other than by opening an existing outline, it
will automatically start a new outline.

Use the Save command on the File menu to save the outline.  The file extension
given to outline files is "OTL".  Bonsai creates a file association so double-clicking on
an outline file will run Bonsai.

Note:
Although Windows supports very long file names, only the first 28
characters of the file name will be used when naming the outline on the
Palm device.

3.17.1.1 Using Another Outline

Open the outline file you use as a template.  Use the Save As command on the File
menu to make a copy of the template.  You can also copy outline files to create new
outlines.

3.17.2 Move Items to Another Outline

Use the Cut Branch - Paste Branch, or Copy Branch - Paste Branch operations to
move items from one outline to another.
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3.17.3 Delete Items

To delete an item, position the caret in the item's title and use the Delete command
from Item menu.  You can also use the Cut Branch command from the Edit menu or
the Cut Branch icon displayed on the bottom of the screen.

If you backspace (or Del) on an empty item, the item is deleted.

The last item in the outline cannot be deleted.

Note:
Deleting a parent item will delete the entire branch.

3.17.3.1 Delete Completed Items

A command is available on the Outline menu to delete all completed items from the
outline.

If all the items in the outline are deleted, a new item is added to the outline.

Items in the outline with the Simple type, which does not have a completion status,
are not effect by this command.

Note:
If a parent is marked complete, the entire branch will be deleted even if
some of the child items are not marked complete, or are Simple items.

3.17.4 Delete an Outline

Use Bonsai's Outline Manager window to delete outlines.  Select the outlines that
you want to delete and right-click.  Select one of the options from the Delete
submenu.  There are 4 options.

· Delete on Desktop and Handheld
The outline file is immediately deleted from the desktop.  During the next
synchronization the outline will be deleted from the handheld.

· From Desktop
The outline file is immediately deleted from the desktop.  During the next
synchronization the Synchronize with Desktop option is unchecked on the
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handheld.
· From Handheld

During the next synchronization the outline is deleted from the handheld.
· Forget

The reference to the desktop outline is removed from the Outline Manager.
This is useful if a temporary outline was opened and now appears in the
Outline Manager.  Or, if an outline belongs to another HotSync User and you
do not want it appearing under the current user.

3.17.5 Rename an outline

Right-click on the outline icon in the Outline Manager window and selected Rename
from the menu.

Outlines that are synchronized with the handheld will be renamed on the handheld
during the next synchronization.

3.17.6 Sort

Both platforms support sorting branches by any of the item attributes.  The outline
can be sorted by 2 attributes, so that if items are equal on the first attribute, the
second attribute is used.  The current branch (where the insertion caret is positioned)
of the outline is sorted.

There are 3 options for the scope of the sort.
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· The sort is only performed on the level of the current item
· Besides the current level, all levels below on the current branch are sorted.
· Sort the entire outline.

When the current item is on the first level, and the second option is selected, the
entire outline is sorted.

The Sort Branch command is located on the Outline menu.

3.17.7 Search the Outlines
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3.17.7.1 Find Command

The desktop application Find command is located on the Edit menu.  The command
searches the current outline for the text. The search starts from the current cursor
location and continues to the end of the outline. A prompt is displayed to continue
the search from the top of the outline.

The search is performed on both the outline title and the notes. Collapsed branches
will be searched. Items that are not displayed because of a filter are not searched.

The found text is selected to highlight it. Use the Find Again command to locate the
next occurrence of the text.

3.17.7.2 Replace Command

The desktop application Replace command is located on the Edit menu. It is used to
find and replace text within the outline and notes.

The search for text to replace starts from the current cursor location and continues to
the end of the outline. A prompt is displayed to continue the search from the top of
the outline.

The search for text to replace is performed on both the outline title and the notes.
Collapsed branches will be searched. Items that are not displayed because of a filter
are not searched.
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3.17.7.3 Google Desktop Integration

The Bonsai Windows application includes indexing and search plug-ins for Google
Desktop. The plug-ins are installed during the Bonsai setup. The indexing plug-in will
appear on the Google Desktop Preferences screen.

Once the Google Desktop has indexed the Bonsai outlines searches for text within
the outlines can be performed.

Bonsai results will be displayed with a Bonsai outline icon for search results.
Selecting that result will launch Bonsai and display the outline and item for the
indexed content.

The Bonsai setup must be run again to install the plug-ins if the Google Desktop is
installed after Bonsai.

Note: The Bonsai search plug-in is not used by the Deskbar for
searches.

3.17.7.3.1  Google Desktop Setup

For the Bonsai indexing plug-in to work it must be enabled on the Google Desktop
Preferences screen. Indexing of Text and Other Files must also be enabled.

If the outline files that should be indexed are stored on a network share then the
share must be added to the list of shares for Google Desktop to index.
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3.17.8 Backup My Outlines

Bonsai stores outlines on your desktop computer in files with the extension OTL.
With Bonsai you are able to create these files in any directory.  When you create a
new outline on your handheld and synchronize the Bonsai conduit creates the
desktop outline in the directory specified in the Settings dialog.

Your desktop backup procedure should include all of your OTL files.

3.17.9 Export an Outline

There are several export formats supported by the desktop application.  Several
predefined formats cannot be customized.  Bonsai also supports customer defined
formats.  Both types are discussed in the following sections.

The export commands are found on the Export menu off the File menu.  The fixed
export formats are listed above the Options menu command.  The customer defined
formats are shown below the Options menu command.
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3.17.9.1 Fixed Format

The formats include; comma separated (CSV), text, HTML, and XML.

A dialog is available to setting options on what is included in the text and HTML
export files.  The dialog is displayed by the Options command on the same menu.

E
Export Type Description

Format Description

XML Creates an XML file that contains all the outline information.  A data
type definition (DTD) file is available in the Bonsai installation
directory.

CSV Creates a comma-delimited file suitable for importing into databases
or Microsoft Excel.

HTML Create a web page.

Text Creates a flat text file.

The order of the columns for the CSV export is as follows;

1. Title
2. Unique Id
3. Item type ( 0=Simple, 1=To Do, 2=Task)
4. Outline depth (0=root)
5. Percent complete
6. Priority
7. Create date
8. Start date
9. Due date
10. Competed date
11. Category text
12. Keywords
13. Contact
14. Note

3.17.9.2 Customer Defined Export

By creating an export template file, you can customize the exporting of a Bonsai
Outline.  Here is a simple example that creates a text file that includes the title,
indents each level by four spaces, and only numbers leaf items.

[HEADER]
Title: #TITLE#

[BRANCH_BEGIN]
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#LEVEL("    ")#TEXT#
[LEAF_BEGIN]
#LEVEL("    ")#NUMBER# #TEXT#

The exported file would look something like the following.

Title: My Outline

Weekend Chores
    1. Clean gutters
    2. Cut grass
Fun things
    1. Go to movies
    2. Go swimming
    3. Take a ride

An Export Template file is a text file that has the extension "OXT".  All template files
stored in the Bonsai installation directory will be shown on the Export menu below
the fixed export formats.  Several example template files are included and installed
by Bonsai.

An Export Template file is made up of sections that describe what will be written to
the export file.  Each section begins with a line containing the section name in the
first column.  The section continues until another section name is seen, or the end of
the file is reached.

Use a text editor, such as notepad, to edit the template file.  Make a copy of one of
the example template files, or start a new file with the extension "OXT".  All section
and substitution names are case sensitive.  Text before the first section name is
ignored allowing comments regarding the template to be placed at the start of the
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file.

Each section contains text that is passed through unchanged to the export file and
substitution names that are replaced with values from the outline.  Not all
substitutions can be used in all sections.  If you use a substitution for an item
attribute (e.g., #NOTE#) in the Header section, an empty string will be inserted.  The
following table defines the sections.
Section Name Section Description

Section Description

[OPTIONS] This is a unique section in that it does not contain text to be
written to the output file, but instead contains options that control
aspects of the export.  The table on the following page defines
the contents of the Options section.

[HEADER] Written at the start of the export file.

[FOOTER] The last section written to the export file.

[ITEM_BEGIN] Written once for each item in the outline.

[ITEM_END] Written once for each item in the outline after the completion of
the branch (all children of the item have been processed).

[BRANCH_BEGIN] Written once for each item that has child items.  When this
section is used, the [ITEM_BEGIN] section is skipped.

[BRANCH_END] Written once for each item that has child items after all the child
items have been processed.  When this section is used, the
[ITEM_END] section is skipped.

[LEAF_BEGIN] Written once for each item that does not have child items.  When
this section is used, the [ITEM_BEGIN] section is skipped.

[LEAF_END] Written once for each item that does not have child items.
When this section is used, the [ITEM_END] section is skipped.

[NOTE] Written once for each item that has a note.  Immediately follows
either; [ITEM_BEGIN], [BRANCH_BEGIN], or [LEAF_BEGIN]

[FOOTNOTE_BEGIN] Written once after all items in the outline have been processed

[FOOTNOTE] Written once for each item that has a note.

[FOOTNOTE_END] Written once after all the [FOOTNOTE] sections have been
written.

The Options section is used to specify control options for the export.  Options are
entered one to a line in an "Option=Value" format.  Blank lines and spaces are
ignored. Here is an example that would be used in a template to generate a web
page.

[OPTIONS]
  EXTENSION=HTM
  MARKUP=1

 Template sections

The following table lists all the supported options.
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Option Description

Option Name Description

OUTPUT The name of the output file. When this option is not defined in the
template, Bonsai will prompt for the output file name using the name of
the outline file as the base name.
Example: "OUTPUT=c:\report.html"

EXTENSION The default file extension for the export file.  This extension is used in
the export file save dialog. If this option is not given, the default is
"TXT".    Example: "EXTENSION=XML"

MARKUP If the markup option is "HTML" or "XML", characters used for markup
languages are converted to special character sequences.  These
changes are made in outline text, notes, categories, and the outline
title.  The template text is not modified.  These sequences are
translated for both "HTML" and "XML".  '>' = "&gt;" '<' = "&lt;" '&' =
"&amp;" '"' = "&quot;"  The apostrophe sequence is only translated for
"XML".  ''' = "&apos;"

Example: "MARKUP=HTML".  The default value is "NONE".

TAG_URLS If the markup option is "HTML", text in the outline item title and notes
that are recognized as URL's are converted to anchor tags of the form
"<a href='URL''>'URL''</a>".
If this option is set to 0 the anchor tag insertion is not done.

MAX_LEVEL This option limits the levels of the outline that are exported.  The default
value of 0 will export the entire outline.  A value of 1 will export only the
outermost level of the outline.  Example: "MAX_LEVEL=2"

NO_DATE This string is used when a replacement is made for a date that is not
assigned.  For example, it a To Do does not have a due date and the
#DUE_DATE# replacement is used; the value of this option will be
inserted.

NO_CATEGORY This string is used when a replacement is made for the Unfiled
category.

CUSTOM_ZERO This string is used when a replacement is made for a Custom value of
0. A typical use would be to suppress a value.

NOTE_NEWLINE Defines a string to substitute for newline characters within notes.
Example: "NOTE_NEWLINE=<br>"

NOTE_NEWLINE_CHAR Defines a single character to substitute for newline characters within
notes. The character value is given in decimal.
Example: "NOTE_NEWLINE_CHAR=127"

PRIORITY Defines a text substitutions for the priority numbers (1..5). Provide a list
of 5 comma separated names.

Example: "PRIORITY=highest,high,medium,low,lowest"

The following substitutions have a single value during the export.
Substitution Description
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Substitution Name Description

#TITLE# The name of the outline file.  Does not include the extension.

#NUMBERING# The type of numbering is used on the outline. 0 – none, 1 – basic.
As Bonsai supports more numbering formats, this list will expand.

#CATEGORIES# The categories as a comma separated list.

#COLLAPSED_ITEMS# The Id's of all the collapsed items as a comma separated list.

#TODAY# Today's date

#NOW# The current time and date

#FILE_NAME# The file name of the outline being exported.

#FILTER_NAME# The name of the active filter used for the export.

As the outline is exported, the following substitutions are given values from each item
in the outline.
Substitution Description
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Substitution Name Description

#POSITION# The location of the item in the outline.  The first item is at position
0.

#ID# A unique number assigned to each item in the outline.

#PARENT# The unique Id assigned to the parent of this item (0 for level 0
items).

#LEVEL# The indentation level of the item.  Items not indented are at level
0.

#LEVEL1# Same as #LEVEL#, but 1 based.

#LEVEL("XXX")# Repeat the quoted string "XXX" by the level number for the item.
For example, if you put a tab between the quotes, you can tab
indent an item by the depth of the outline.  Items at the outer level
insert an empty string.

#TYPE# The item type.  0 – Simple, 1 – To Do, 2 – Task

#NUMBER# The outline numbering for the item.

#FULLNUMBER# The outline numbering where all levels are included (e.g., "2.3.1")

#PERCENT# The percent complete for an item.  If the item is a Simple type, the
string is empty.

#STATUS("N","Y")# If the item is not completed, insert the first quoted string.  If the
item is completed, insert the second quoted string.  If the item is a
Simple type, an empty string is inserted.

#TODO_STATUS("N","Y")# If the item has the type To Do, then the text from the quoted
strings are replaced as done with STATUS.  Otherwise, an empty
string is inserted.

#TASK("string")# If the item has the type of Task, then the quoted text is inserted.
Otherwise, an empty string is inserted.

#SIMPLE("string")# If the item has the type of Simple, then the quoted text is inserted.

#CREATE_DATE# The date the item was created.

#START_DATE# The start date. If the item is a Simple type, an empty string is
inserted.

#DUE_DATE# The due date.  If the item is a Simple type, an empty string is
inserted.

#COMPLETED_DATE# The completed date.  If the item is a Simple type, an empty string
is inserted.

#CREATE_DATEN# The date the item was created as the number of seconds since
Jan. 1, 1970.

#START_DATEN# The start date created as the number of seconds since Jan. 1,
1970. If the item is a Simple type, an empty string is inserted.

#DUE_DATEN# The due date as the number of seconds since Jan. 1, 1970.  If the
item is a Simple type, an empty string is inserted.

#COMPLETED_DATEN# The completed date as the number of seconds since Jan. 1, 1970.
If the item is a Simple type, an empty string is inserted.

#ELAPSED_DURATION# The number of days between the start date and the end date
inclusive. If the item is a Simple type, an empty string is inserted.

#PRIORITY# The priority.  A value of 0 is used for a priority value of none.

#PRIORITY_NAME# The priority text for the priority of the item. See the PRIORITY
parameter in the option section. An empty string is used for a
priority value of none.

#CATEGORY# The category name.
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3.17.9.3 Command Line Template Export

The Bonsai Windows application can perform a command line export of an outline
using a customer defined template file.  This can be useful if you have an outline that
is regularly exported to an intranet after synchronization.  The syntax of the export
command is:

BONSAI /EXPORT <outline file name> <template file name> <output file> [
/filter:<filtername> ]

The filter option is optional.  The filter name is case sensitive and there are no
spaces between the option and the name of the filter.

The values returned by Bonsai for the export command are as follows.

· 0 - The import was completed without error.
· 1 - Not able to read the outline file. The file name may be invalid.
· 2 - Not able to read the template file.  The file name may be invalid.
· 3 - Not able to write the output file.  The file name may be invalid.

The user interface is not displayed when this command line option is used.

Note:
Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.9.4 Command Line XML Export

The Bonsai Windows application can perform a command line export of an outline to
XML. The syntax of the export command is:

BONSAI /XMLEXPORT <outline file name> <output file>

The entire outline is always exported. All of the outline's attributes, including filters,
display columns, expand - collapse state are included in the XML output.  The
definition of the format is described in the file "bonsai.dtd" that is installed in the
Bonsai application installation directory.

The values returned by Bonsai for the export command are as follows.

· 0 - The import was completed without error.
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· 1 - Not able to read the outline file. The file name may be invalid.
· 3 - Not able to write the output file.  The file name may be invalid.

The user interface is not displayed when this command line option is used.

Note:
Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.10 Import Data
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3.17.10.1 From a Text File

The desktop application supports importing from a text file.  Each line in the file is
used to create an item in the outline.  Tabs at the start of each line are used for the
outline levels.

The import command is located on the File menu. The command creates a new
outline with the imported information.  After performing the import, the save
command will create a new Bonsai outline file.

3.17.10.2 From a Comma-Delimited File

The desktop application supports importing an outline from a comma-delimited file
(file extension 'CSV').  Each line in the file is used to create an item in the outline.
There are 2 formats that can be used.

1. The fields in the CSV should follow the same order as the standard Bonsai
CSV export.

2. The first line of the CSV provides the column names that are present in the
CSV file.

Requirements for the CSV include the following.
· A comma must separate each field.
· Text fields must be in double quotes
· The unique Id field can be 0, in which case Bonsai will assign a value.

Example line for fixed format:

"A
test","0","1","0","0","3","4/16/01","4/16/01","4/17/01","4/17/01","Business","@Home","Smith","
A note"

Example when providing a line that specifies the columns present in the CSV file:

"text","notes","category"
"A test","Some Notes","Business"
"Second item","Notes on the subject","Personal"

The Import command is located on the File menu.  The command creates a new
outline with the imported information.  After performing the import, the save
command will create a new Bonsai outline file.

Bonsai will also import a CSV file when it is dropped on the application window.

The column names used in CSV files are as follows.

"unique-id" or "id"
"create-date" or "created"
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"start-date" or "start"
"due-date" or "due"
"completed-date" or "completed"
"level"
"precent-complete" or "precent"
"priority"
"type"
"custom"
"contact"
"keywords"
"text"
"notes"
"category"

3.17.10.3 From an XML File

The Bonsai Windows application can perform a command line import of an XML file.
This can be useful if you have an external source of data that you want to automate
the import and synchronization with your handheld.  Bonsai supports several outlines
that use XML;

· The Bonsai XML export format.
· Outline Processor Markup Language - OPML
· Mind Map
· Mind Manager
· Shadow Plan

The syntax of the import command is:

BONSAI /IMPORT <import file name> <outline file name> [ /sync:(0|1) ] [
/user:<HotSync User Name> ] [ /category:<category> ]

The sync and user parameters are optional.  By default, the created outline will be
configured to synchronize with Bonsai's current HotSync User.

Use the user parameter if you have more than one HotSync User on your desktop
and need to direct the outline configuration to a specific user.  Use quotes around
user names that include spaces.

Include the parameter "/sync:0" to disable synchronization for the outline.

The values returned by Bonsai for the import command are as follows.

· 0 - The import was completed without error.
· 1 - Not able to write the outline file.  The file name may be invalid.
· 4 - Not able to read the XML file.  The file name may be invalid.

http://www.opml.org/


Bonsai Outliner for Windows 91

© 1999-2007 Natara Software, Inc.

· 5 - Not able to update the shortcut file.
· 6 - The HotSync User name is not valid.

The user interface is not displayed when this command line option is used.

Note:
Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.10.4 From Other Palm OS Outliners

The Bonsai Windows application can import from several other Palm OS outliners.
Use the File Import command or simply drag and drop the backup of the Palm
outliner database (extension ".PDB") onto the Bonsai application.

Supported formats;
· ThoughtManager
· BrainForest

3.17.10.5 Command Line Import

The Bonsai Windows application can perform a command line import from a CSV
file. This can be useful if you have an external source of data that you want to
automate the import and synchronization with your handheld.  The layout of the CSV
file is the same as that produced by the CSV export command.

The syntax of the import command is:

BONSAI /IMPORT <import file name> <outline file name> [ /sync:(0|1) ] [
/user:<HotSync User Name> ] [ /category:<category> ]

The sync and user parameters are optional.  By default, the created outline will be
configured to synchronize with Bonsai's current HotSync User.

Use the user parameter if you have more than one HotSync User on your desktop
and need to direct the outline configuration to a specific user.  Use quotes around
user names that include spaces.

Include the parameter "/sync:0" to disable synchronization for the outline.

The values returned by Bonsai for the import command are as follows.

· 0 - The import was completed without error.
· 1 - Not able to write the outline file.  The file name may be invalid.
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· 4 - Not able to read the CSV file.  The file name may be invalid.
· 5 - Not able to update the shortcut file.
· 6 - The HotSync User name is not valid.

The user interface is not displayed when this command line option is used.

Note:
Use the full path and extension to the file names on the command line.
Use quotes around file names that include spaces.

3.17.11 Link to External Resources

The Bonsai desktop application supports several external resource links, such as
URL's. The links can appear in both the outline item's title and notes.

The hand cursor is displayed when the mouse is positioned over a link. Left clicking
on a link will pass the link to the Windows to open. The color used for links can be
configured in the Settings dialog.

Bonsai recognizes the following types of external resources.

· http://
· https://
· ftp://
· mailto:
· file:/// Drive letter based file path. "file:///C:\temp.txt".
· file:\\ UNC based file path. For example

"file:\\ComputerName\ShareName\temp.txt".
· outlook:
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The Insert File Link command on the Edit menu can be used to insert a properly
formatted file link.

Spaces are not allowed within the links.  Use '%20' to represent spaces. For
example; "file:///C:\Program%20Files\memo.txt". The Insert File Link command will
automatically translate the spaces.

Note: Bonsai will pass the full external resource link to Windows. What
Windows does with the link will depend on how you have Windows
configured. Bonsai does not attempt to determine what application
will handle the external resource link.

3.17.12 Jump Back from a Link

The Windows desktop application does not have a corresponding application to the
Back-2-Bonsai handheld applications.  However, it does have some support through
the command line and keyboard shortcuts.

Bonsai has a keyboard shortcut, Alt+J, that will take a link tag number from the
Windows clipboard and open the outline and position the cursor to the linked item.

To use this feature, highlight a Bonsai link tag in the Palm Desktop or Microsoft
Outlook and copy it to the Windows clipboard (usually Ctrl+C).  Switch to the Bonsai
application and enter Alt+J.

If you can not copy the link tag number to the clipboard, use Alt+Shift+J to display
the Jump to Link dialog.  The dialog accepts the link tag number.



Natara Bonsai User Manual94

© 1999-2007 Natara Software, Inc.

The command line option "/linktag:#" is available to perform the same action as the
keyboard shortcut described above.  The command line option can be used from
scripting languages to automate the jump to link. An example that works with
Microsoft Outlook is provided with the Bonsai installation. The following command
line would display the outline that referenced link tag number 9.

BONSAI /linktag:9

If the Bonsai application was already running, the request is passed to the Bonsai
application and it will display the outline.

Note: Each HotSync User has their own set of Link Tag numbers. The
corresponding HotSync User must already be selected in the Bonsai
Windows application.

3.17.12.1 MS Outlook Example

An example macro is included with the Bonsai installation that demonstrates the
ability to launch Bonsai and display a linked item.  By placing a button linked to this
macro on the Outlook toolbar, and the forms for task and event details, you can
quickly jump to the Bonsai outline with the linked item.

Here are the steps to install this example.

Install the macro
· Hit Alt+F11 from within MS Outlook to open a MS Visual Basic window.
· Right click on the Project icon in the Project Explorer window and select Import

File from the context menu.
· Navigate to the Bonsai installation directory and select "Back2Bonsai.bas".
· If Bonsai was not installed in the default folder under Program Files, then edit the

Launch Bonsai function in the module and change the path to the actual
installation folder.

· Save the project (click save icon) and close the Visual Basic editor.
Create a toolbar button

· Right-click on the MS Outlook toolbar and select Customize from context menu
to display the Customize dialog.
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· Select 'Macros' in the Categories list.
· Click and drag the 'DoBonsai' macro from the commands list to the MS Outlook

toolbar.
· Before closing the Customize dialog, right-click on the 'DoBonsai' button on the

MS Outlook toolbar to display the context menu.
· Find the Name entry on the menu and change the button name to Back2Bonsai.
· Optionally, the icon can be changed using the same context menu.
· Close the Customize dialog.

The Back2Bonsai button is now configured and ready for use.

Place your cursor on a To Do that contains a Bonsai link tag and click the
Back2Bonsai button.

Repeat the procedure used to create the toolbar button on other forms, for example
Task Details, where you want to jump to Bonsai.

Note: If you get an error "Macro language support is disabled", you may
have the Visual Basic for Application shared features disabled.

Note: MS Outlook 2003 has additional security on the body of a task or
event that will cause a security pop up to be displayed.  See the
script source code for information on the Redemption Library and
other ways to work around this message. Otherwise, you can
respond Yes to the security dialog.
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3.17.12.2 Palm Desktop Example

An example Palm Desktop add-in is included with the Bonsai installation that
demonstrates the ability to launch Bonsai and display a linked item.  This add-in is
automatically registered with the Palm Desktop when Bonsai is installed.

When you run the Palm Desktop you should see the Back-2-Bonsai icon on the
toolbar.

Click on a To Do or Event that contains a Bonsai link tag within the Palm Desktop
application. Then click the Back-2-Bonsai button.  The Bonsai application will be
launched and the cursor positioned on the linked item.

3.17.13 Reuse an Outline

Bonsai has a command to clear the status for all items in an outline.  The Reset
command is located on the Outline menu.  The operations performed on the outline
are:

· Clear all To Do check boxes
· Set percentage complete of all tasks to 0%.
· Set all dates (start, due, completed) to the 'no date' value
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3.17.14 Filter for Overdue Items

To create a filter that will display overdue items, set the Status to "Incomplete" and
set the Due Date to "Due Within 0 days". You can vary the day to include items that
will be due soon.
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4 Bonsai Outliner for Palm OS

This topic describes the Bonsai outliner application for the Palm OS.

4.1 Launching Bonsai

Once Bonsai is installed on the Palm OS handheld an icon will be displayed on the
Application screen. Tap on the Bonsai icon to start Bonsai.  Bonsai will return to the
outline that you were last working on.
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4.2 Main View

This is the outline view with a number of attributes shown.  Since this leaves little
room for the outline text, usually only a few of the attributes are shown.  Configuring
what is shown is done through the column header and the Preferences dialog.
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Edit the outline text directly in this view.

The grab handles are used for drag and drop operations.

Edit the notes by tapping on the note icon.

Quickly change a date by tapping on the date column.

The tools that are displayed on the toolbar can be configured in the Settings dialog.

Tap the  icon to switch tool sets.

Tap on the filter selection to filter the outline or to edit the filters.

Tap on the link column to create a new link, or jump to where a link points.

4.2.1 Views

The Bonsai application on the handheld uses Views to manage what attributes of the
outlines are shown. When a new outline is created a default view is created. You can
add additional views using the Views dialog.  You can then configure the views to
show different attributes of the outline.  Bonsai remembers the columns and widths
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for each view.

The columns available for display include;
· Text
· Note icon
· Link icon
· Start date
· Due date
· Completed date
· Days until due
· Category
· Category icon
· Contact
· Contact icon
· Keywords
· Keyword icons
· Custom

There are 4 ways of switching the current view;
· The View command on the View menu.
· Select View from the menu displayed when tapping on the column header.
· Use the Views toolbar button (configured in the Settings dialog).
· When switching between portrait and landscape modes on handhelds that

support both orientations.

Tap on the outline header to display a menu of options. When adding columns to the
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header, the column will be inserted to the left or right of the column that was tapped
depending on which side of the column was tapped.

Commands available on the header menu include;

Command Description

Hide Header Collapsed the outline header to a narrow line. This increases the
space available to display the outline.

Sort Ascending Displays the Sort dialog with the current column selected and
ascending as the sort option.

Sort Descending Displays the Sort dialog with the current column selected and
descending as the sort option.

Hide Column Hides the column that was tapped.  No action is taken on the
text column.

Show Column... Displays a menu of columns that can be displayed.

View... Displays the View dialog where Views can be added, deleted, of
selected.

4.2.2 Edit Views
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4.3 Zoom in on a Branch

Bonsai has the ability to zoom in on a branch.  Since there is less room on the
handheld screen than the desktop, it may be necessary to zoom in on a branch to
view or edit the text.

When zoomed on a branch the title of the outline is replaced by the name of the
branch.
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Before Zoom After Zoom

The Zoom Out command returns to the original view.

4.4 Grouping Outlines

Use the category capability of Bonsai to group related outlines.  You can filter your
outlines by category on the outline list view.  If one of the hard application buttons is
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assigned to Bonsai, pushing the button will cycle through the categories on this view.

4.5 Item Details

Besides its title, each item has an additional set of attributes.  When not displayed on
the outline view, these attributes can be viewed and set on the details dialog. The
following topics describe the information on each tab.

4.5.1 General Tab

The General tab contains the item type, category, and priority and completion status.
The information shown on the General tab is dependent on the item's type. Simple
items do not have a completion status.
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4.5.1.1 Type

Each item in an outline is one of 3 types: simple, to do, and task.  The type assigned
to an item when it is added to the outline is controlled by a preference.  The type can
then be changed from the details view.

A Simple item can be changed to either a To Do or a Task by tapping (or right click)
on the status icon and selecting the type from the pop up menu.  With the desktop
application, right click on the completion status to display the item type menu.
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4.5.1.2 Status

Items of type To Do and Task have a completion status.  To do's are either done, or
not done.  Tasks have a completion status between 0% and 100%.  The status can
be set directly on the details dialog.  The hard scroll buttons will change the percent
complete of a task by 10% for each press.

The status of an item can also be set from the outline view when the completion
status is shown (a preference setting).  Tap (or left click) on the progress bar and
drag left and right to change the percent complete.

On both the desktop and Palm device, command and shortcuts are provided that
toggle the completion status



Bonsai Outliner for Palm OS 109

© 1999-2007 Natara Software, Inc.

When you change the completion status of an item, the completion status of its
parent items is recalculated.  A preference setting is available to disable this
behavior.

4.5.1.3 Priority

Each item has a priority from 1 to 5, or no assigned priority.  Priority 1 is considered
the most important.  You can filter the outline with a priority.  The priority of an item
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can be set from the outline view when the priority is shown (a preference setting).

The priority assigned to new items can be set in the preferences.

4.5.1.4 Category

Categories provide a customizable attribute that can be used as desired.  Each item
in the outline can be assigned to a category, or left unfiled.

The outline can be filtered on category.  For example, you could use the categories
with a To Do list to indicate the best time of day to perform the work.  You could then
filter your To Do list on time of day.
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Note:
Categories use the Palm OS category feature, and are limited to 15
user-defined categories.
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4.5.2 Dates Tab

The Dates tab has the dates for items with a type of To Do or Task.

The dates of parent items can not be modified if the option to roll up dates is
configured.

4.5.2.1 Dates

Items of type To Do and Task also have a Start, Due and Completion date.  When a
To Do is checked completed, or a Task is marked 100%, the completion date is set
to the current date.  The completion date can also be manually set to another date.

Besides the ability to select a date from the calendar, the Palm application provides a
menu of quick dates.  The entries on the menu are specific to the start, due, and
completion date uses. The pop-up menu is available from both the details dialog and
the outline view (when a column of dates is shown).

The pop up menu on the outline view is also used to switch the display to one of the
other dates.
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When you change the start or due date of an item, the start and due dates of its
parent items are recalculated.  A preference setting is available to disable this
behavior.
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4.5.3 Links Tab

An item can be linked to either another Bonsai outline, an event in the date book, or
a standard To Do. Links can be set in the details dialog of an item.  Tapping on the
link icon will jump to the to do, event, or outline.

An item can also be associated with a contact name.  Bonsai will auto-complete this
field with names from the build-in address book.  However, you can put any text in
this field.

One or more keywords can be assigned to the item.  Keywords are selected from the
keyword dialog.

The presence of a link is show with an icon on the right hand side of the screen.  A
preference setting controls display of the icon.  Tapping on the link icon will pop a
menu to either jump to the linked item, or unlink the item.  Tapping on an unlinked
item, represented by the hollow diamond, will present a linking menu.

The link icons are as follows;
The item is not linked.

Item is linked to a To Do.

Item is linked to an event in the date book.

Item is linked to a Bonsai outline.
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4.5.3.1 To Do Links

Setting a to do link can be done from the details dialog.

When an item is linked a new To Do is created in the built-in To Do database using
the attributes of the item (Name, Note, Priority, Due Date, Completion Status,
Category).

If there is a category in the standard To Do database that matches the category of
the item in the outline, the linked to do will assigned that category.  Otherwise, the to
do will be assigned the unfiled category.

Tapping on the To Do link icon will jump to the To Do. The application launched is
configured in the Settings dialog. Bonsai can insert a link tag into the To Do to
indicate that the To Do is associated with a Bonsai outline.  Configuring this option is
also done in the Settings dialog. When link tags are used it is possible to jump back
to the Bonsai outline from the To Do application.  Instructions for installing and
configuring this option are given in the Back-2-Bonsai topics.
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Unlinking the item, or changing the link type to outline, will break the link to the To
Do.  The To Do is removed from the standard To Do database if the application
setting is enabled for this option.

Note: Changes made on the desktop to an item linked with a To
Do require 2 synchronizations before they appear in the desktop PIM
application.  On the first synchronization the changes are propagated to
the handheld To Do database.  On the second synchronization the
changes are propagated to the desktop PIM application by the PIM
HotSync Manager conduits.

4.5.3.2 Outline Links

Linking an item to another outline is done in the details dialog.  The name of the
linked outline will be displayed below the link selection.  Tapping on the outline link
icon (the tree) will jump to the linked outline.
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The link can be thought of as a master project to subproject link.  The link points to
another outline, and not to an item.  Changing the selection will break the link to the
other outline.

4.5.3.3 Calendar Links

Linking an item to an event in the date book is done on the Links tab. When the
Calendar pushbutton is tapped, Bonsai displays the Select Event dialog.  There is an
option to create a new event if the event does not yet exist.

Bonsai displays the calendar icon and the title of the linked event.  Tap on the
calendar icon to jump to the event.  The application launched is configured in the
Settings dialog. Bonsai can insert a link tag into the event to indicate that the event is
associated with a Bonsai outline.  Configuring this option is also done in the Settings
dialog. When link tags are used it is possible to jump back to the Bonsai outline from
the Calendar application.  Instructions for installing and configuring this option are
given in the Back-2-Bonsai topics.
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When a new event is created by linking, Bonsai will attempt to match the category of
the outline item with a category in the date book.  If a match is found, then the new
event is assigned to the category.  Otherwise, the Unfiled category is used.  This is
only relevant for handhelds that support categories in the date book.

Note:
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Adding a link to an event can only be done on the handheld. The event
links are visible on the desktop.

4.5.3.4 Keywords

One or more keywords can be assigned to an item. Keywords are useful when
filtering an outline. Icons can be assigned to keywords.

You can assigned multiple keywords to an item on the desktop in one operation.
Click on the Add button to display the Select Keywords dialog. Select each keyword
to be added to the item and click OK.

By default the keywords will be appended to the item's existing keywords. By
checking the replace option, the existing keywords will be removed before added the
new keywords.

You can also assigned keywords to multiple items in an outline in one operation.
Select all the items using the selection gutter and select Keywords from the Item
menu.

4.5.4 Text

An alternative way of editing the item's title is the Text tab of the details dialog.  This
can be useful if the text is too long for the handheld screen.
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4.5.5 Notes

Tap on the note button to display and edit the note.  Each item can have a note up to
32K.

A note icon can be displayed on the outline view to show what items have notes.
Tap on the icon to display or edit the note.
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4.6 Keywords

Bonsai maintains a single list of keywords that is shared by all outlines. When adding
keywords to items in an outline this list is displayed.  Keywords are assigned to
categories for grouping.

The keyword list is global to all outlines.  Keywords are inserted into outlines as text,
and not as references to the global keyword list.  Changes you make to the global
keyword list are not reflected in the outlines.

Icons can be assigned to the keywords. The icons can then be displayed in the
outline instead of the keyword text.

Keywords for items are shown on the Links tab of the details dialog.
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When all keywords are shown (see desktop example above), the category is
appended to the keyword for display. When a category is selected, as with the
handheld example, the category is not appended to the keyword.

Note:
During synchronization the most recent set of keywords (desktop or
handheld) is copied over the other set.  For this reason, perform
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keyword maintenance on one side between each synchronization.

4.7 Filter the View

Bonsai supports the ability to filter the items that are displayed.  To access the dialog
to create new filters or edit existing filters; tap the filter drop list in the upper-right of
the handheld screen.

Several attributes can be filtered at one time.  Only items that match all the selected
attributes will be displayed.  For example, it is possible to filter for priority 1
incomplete items from the business category.

An existing filter can be enabled by selecting it from the filter drop-list.

Note: The current filter is automatically disabled if none of the items in the
outline match the filter.

4.7.1 Filter List

Select a filter to use, or create and edit filters from this dialog.

If you have create a set of filters in another outline that you would like to reuse, use
the Import option to copy them into this outline.

Select Use Filter to activate the selected filter.
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4.7.2 Filter Definition

The filter definition is divided onto several tabs.

4.7.2.1 General

The first tab contains the filter name and several criteria.

The following filter attributes are on this tab.



Bonsai Outliner for Palm OS 125

© 1999-2007 Natara Software, Inc.

Filter Attribute Description
Name Assign a name to the filter to describe its action
Status Filter to do's and tasks based on the completion

status.
Type Filter on item type; Simple, To Do, and Task.
Priority A number of options to filter on priority.
Link Filter based on whether the item is linked or not.
Text A string to search for.  Check the Also search notes

option to search for the string in notes.

Attribute When checked  only these items are included

4.7.2.2 Options

This tab has options that affect the overall filter operation.

The following filter attributes are on this tab.
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Filter Attribute Description
Limit view to Next Action... When the "Limit view..." option is selected Bonsai will

seleect a single child item to display for parents with
the Parent of Next Action Items attribute. The order
used for ranking the children can be selected here.

Display results as a flat list When this option is checked the results of the filter
are displayed as a flat list.

Scope By default the filter is applied to all items in the
outline. There are two options for limiting the filters
use.

Reverse Filter Action When this option is checked Bonsai will reverse the
results of checking the filter against a single item.

Attribute When checked  only these items are included

4.7.2.3 Dates

This tab contains date and contact filtering options.

4.7.2.4 Category

This tab contains category filtering options. The filter will only include items whose
category is checked.
Bonsai will not let you define a filter without at least one category checked.
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4.7.2.5 Keywords

This tab contains keyword filtering options. Since you can include more than one
keyword in the filter, there is a set of  options that affects how the keywords are
matched.
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4.8 Beaming

Beam outlines using the Beam command from the list of outlines.  Select the outline
to beam from the list of outlines.

On the receiving handheld, use the menu command View -> Refresh to scan for the
received outline.

The Bonsai application can also be beamed to another Palm device.  Bonsai will run
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on the new device in the 30-day trial mode.  The command is located on the Options
menu.

4.9 Preferences

The preferences dialog is available from the Options menu.  Note that each outline
has its own set of preferences.  Be sure to have the correct outline open when you
modify the preferences.

The initial value for the preferences is taken from a set of defaults.  The section
following this describes how to change those default preferences.  The preferences
are grouped onto tabs.

4.9.1 General

This tab has general display options. In general, the more attributes selected for
display, the less room for the outline text.

Numbering Options
reference Description
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Option Description

Level 1..8 Pick the style of numbering to be used for the outline at each level

Show All Numbers to Level Select the last level that should include all levels in the outline
numbering.  For example "1.2.1".

Current View Options
efPreference Description

Option Description

Show Completion Status When checked, check boxes and progress bars are shown for each
item. This option displays the status for the current view.

Show Priority When checked, the priority of each item is displayed. This option
displays the status for the current view.

Show Numbers When checked, outline numbers are shown according to the
definition on the Number tab. This option displays the status for the
current view.

4.9.2 Misc

This tab has miscellaneous display preferences.

Perence Description
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Option Description

# of lines displayed per item When set to All, Bonsai will show all of the item's title in the
outline (as long as it fits on the screen).  When the entire
item is displayed, you can edit the text directly in the
outline.  Set this option to another value if you want to
restrict the number of lines displayed for each item.

Dates Select what elements of the date should be displayed on
the outline view.  You can select: Day - Month, Month -
Year, or Day – Month – Year.  This preference does not
control what order is used (Day-Month, or Month-Day).
The Palm OS date preference is used for formatting.

Custom Label The label displayed for the Custom numeric attribute.

Color completed items When checked, the text of completed items will be
displayed in this color.

4.9.3 Calculated

This tab has options that control the calculation of parent values from children. When
the option is checked the value of the parent will be calculated from its children.
There are three options.

Completion Status
Check this option to calculate the percent complete or checkbox status from the
children items.

Dates
Check this option to calcuate the Start, Due and Completion dates from the children
items. The start date of  the parent will be the earliest child date. The due date and
completion date of the parent will be the latest date of the children.

Custom Numeric Field
Check this option to calculate the parent's custom numeric value from the children
items. There are several options for the calculation.
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4.9.4 New Item

This tab contains options for new items, and computing parent status from children.

Several of the preferences have selections of Parent's or Sibling's.  This allows the
automatic selection of the initial value when the item is added to the outline.  If
Sibling is selected and the item is the first child (i.e., it has no sibling), then the
attribute is taken from the parent.
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Option Description

Type Select the type initially assigned to new items.

Priority Select the priority initially assigned to new items.

Start Date The date assigned to the start date for new items.

Due Date The date assigned to the due date for new items.

Category The category assigned to new items.

Keywords The keywords assigned to new items.

Auto-link To Do When checked, new To Do's added to an outline will automatically
be linked to the standard To Do's.

4.9.5 Font

This tab shows the fonts used to display the outline and notes.  Tap on the example
to display the font select dialog.

4.9.6 Colors

This tab is used to define a coloring scheme for an outline.  The "Color by" selector
has a list of several attributes.  They include; Category, Priority, Outline Level, and
Due Date.  Tap on the color box to display the color selection dialog.

Bonsai will remember a color scheme for each Color By selection.
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4.9.7 Category Icons

This tab is used to assign an icon to each category. If there is an icon set present on
the handheld, tapping on the box next to the category name will display the
icon selection dialog.
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4.10 New Outline Defaults

Each outline has its own preference settings that determine how it looks and
behaves.  Once an outline is created, these settings can be modified without
affecting other outlines.

Bonsai has a set of initial preferences that are given to all new outlines.

The preferences dialog displayed from the view that shows the names of outlines is
used to define the settings for new outlines.  Changing a setting in this dialog does
not affect any existing outlines.
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4.11 Settings

Application settings apply to all outlines.

4.11.1 Display

This tab has general display options.
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Setting Description

Setting Description

Background Colors The alternating background colors used for the outline.

Indentation Size Set to configure how far each level is indented.  You may want to
decrease from the default value if you use heavy indentation to
provide more room for text.

Shade Toolbar When checked, the toolbar area will be shaded.

Show guidelines on notes When checked, guidelines are shown in the notes edit dialog.

Show Simple when Status
Filter

Normally, Simple items are filtered out whenever a filter with a
status is used.  Checking this option will cause Simple items to
match any status filter setting.

Reapply filter while editing When checked, Bonsai will compare an active filter against an item
being edited.  If any changes to the item cause the item to no
longer match the filter, it will immediately disappear from view.

Remember input area status When checked, Bonsai will restore the input area to the state when
Bonsai last exited. When unchecked, Bonsai will leave the input
area as it was when Bonsai was launched.

Reset List Columns To
Defaults

Checking this option will reset the columns used in the outline list
view when OK is tapped.

4.11.2 Toolbar

This is the toolbar tab of the settings dialog.
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Select the icons to appear on the toolbar.  To change the icons displayed on the
toolbar, tap on the icon and select a new command from the list.

The available toolbar commands are;

Close this outline and display the list of outlines.

Return to the previous outline or list of outlines.  Useful when using
outline links.

Add a new item as a sibling of the current item.

Add a new item as a child of the current item.

Display details of the current item.

Display the details Dates tab for the current item.

Display the details Links tab for the current item.

Perform a Find or Find Again command.

Expand or collapse the outline to a specific level (selected from pop up
list).

Displays a list of recently used outline.  Select an outline from the list to
open it.
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Displays the preferences dialog.

Displays the View selection menu.

Cuts the current branch.

Pastes a branch from the clipboard.

Copies the current branch.

Displays the sort dialog.

Deletes the current branch.

Displays the note for the current item.

Move the current item up (before the previous sibling).

Move the current item down (after the next sibling).

Indent the current item (makes it a child of its previous sibling).

Outdent the current item (makes it a sibling of its parent).

Zoom in on the current branch.

Zoom out one level.

Turn off the zoom.

Import To Do's

4.11.3 Links

This is the Links tab of the settings dialog.
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Setting Description

Deleted linked To Do on
unlink

When checked, deleting or unlinking an item that is linked to a
standard Palm OS To Do will delete the To Do from the standard
To Do database.

Insert Bonsai link tag in target When checked, Bonsai will insert a special character sequence into
linked items. The tag has the format "[BZ#]". By using the Back-2-
Bonsai add-on you can view the link context and jump to the Bonsai
outline from the linked To Do or Event.

Append link tag to notes When checked, the link tag is inserted into the notes of the target. If
not checked, then the link tag is inserted into the title.

To Do App Specifies what application is launched when the link icon of a linked
To Do is tapped.

DateBk App Specifies what application is launched when the link icon of a linked
event is tapped.

Contact App Specifies what application is launched when the contact icon is
tapped.

4.11.4 Options

This tab has some general application options.
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Setting Description

Setting Description

Delete item clipboard on close Storage can also be at a premium on a Palm OS device.  By
default, items left in the clipboard are deleted when Bonsai exits.  If
you want to make those items available the next time you run
Bonsai, uncheck this setting.  This does not effect text selections in
the clipboard.

Enter splits item text When unchecked, a return graffiti stroke or enter key will start a
new item without changing the item where the caret is placed.
When checked, the title of the current item is split at the caret
location to create the new item.  This operation is similar to a word
processor.

Sort No Date to end of list Controls how the 'No Date' value is sorted in relation to other dates.

Ignore Global Find When checked, Bonsai will ignore the Palm's global find requests.

Initial categories When creating a new outline, this setting determines the initial set
of categories given to the outline.  The selections are; Standard,
Outline, To Do's, and Empty.  The standard set of categories is:
Business, Personal, and Unfiled.  The Outline set of categories is a
copy of the categories used to categorize the outlines themselves.
The To Do category set comes from the standard To Do database.
The empty set will only contain Unfiled.
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4.11.5 Navigation

This is the navigation tab of the settings dialog.

Setting Description

Soft Arrows Scroll by Page Select whether the on screen arrows scroll by a line or
page.

Jog Wheel Scroll by Page Select whether a jog wheel scrolls by a line or page.

Jog Select Select operation of a Jog wheel select.  The options are;
details, note, expand/collapse, and toggle To Do check
mark.

Options for the 5-way DPAD:

Select Select the operation for the select button.  The options are;
details, note, toggle To Do check mark, expand - collapse.

Left-Right Select the operation for the Left and Right buttons. The
options are; expand - collapse, cursor left - right, cursor up -
down, indent - outdent, Uncheck - Check, and Zoom out-in.

Options L-R Select the operation for the Left and Right buttons when the
Option button is also held down. The options are; expand -
collapse, cursor left - right, cursor up - down, indent -
outdent, , Uncheck - Check, and Zoom out-in.

Up-Down Select the operation for the Up and Down buttons. The
options are; cursor up - down, page up - down, move up -
down, and expand - collapse.

Option U-D Select the operation for the Up and Down buttons when the
Option button is also held down. The options are; cursor up
- down, page up - down, move up - down, and expand -
collapse.
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Note: Devices like the Palm Treo 650 SmartPhone support the
Option key with the 5-way navigation buttons. The select button is used
to switch between edit mode and navigation between controls. The
Option-Select will perform the commad configured for Select.

4.11.6 Confirmation

This is the confirmation tab of the settings dialog.

This setting page provides confirmation prompts for delete operations.

4.12 Handheld Shortcuts

While editing an outline on the handheld the keyboard shortcuts for Bonsai are as
follows.

A Display item note.
B Go to bottom of outline.
C Copy selected text.
D Delete current item from outline.
E Return to the list of outlines.
F Find.
G Find next occurrence of text.
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H -
I Indent current branch.
J Cut current branch to the Bonsai clipboard.
K Display keyword dialog.
L Display details of the current item.
M Move current item up (before the previous sibling).
N Insert a new child item of the current item.
O Outdent the current item.
P Paste text from the clipboard into current item.
Q Toggle the completed status of current item.
R Display the outline preferences dialog.
S Select all the text for the current item.
T Go to the top of the outline.
U Undo the last text editing operation.
V Move the current item down (after its next sibling).
W Copy the current branch to the Bonsai clipboard.
X Cut the selected text.
Y Paste the branch from the Bonsai clipboard.
Z File the current branch DayNotez.
+ Expand the current branch.
- Collapse the current branch.
> Expand all branches.
< Collapse all branches.
1 Sort the outline (displays the Sort dialog).
2 Display the Filter dialog.

4.13 Handheld Toolbars

The toolbars for the handheld application are defined on the Toolbar tab of the
Settings dialog.

4.14 Printing

Bonsai has support for two print engines:

· PalmPrint Palm OS print driver from Stevens Creek Software
· TealPrint Palm OS print driver from TealPoint Software

Using PalmPrint or TealPrint you can print your outline on compatible printers directly
from your Palm device. For example, you can walk up to an infrared equipped
printer, select an outline or note, and out comes your hard copy.

The print command on the Palm OS application prints the outline as shown.  You
can expand and collapse and use the filter to print the desired items.

Visit the Stevens Creek web site at http://www.stevenscreek.com/pilot for more
information about PalmPrint.

http://www.stevenscreek.com/pilot
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Visit the TealPoint web site at http://www.tealpoint.com/softhome.htm for more
information about TealPrint.

4.15 Outline Management

http://www.tealpoint.com/softhome.htm
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4.15.1 Outline List View

This view lists the outlines that are present on your handheld.  Operations performed
on an entire outline are done from this view.  Such as;

· Open the outline
· Display the outline details
· Set the outline category
· Copy
· Delete
· Archive
· Export
· Beam
· Reset completion status and dates
· Rename

The columns that can be displayed as listed in the following table.

Column Description

Name The name of the outline

Category The category of the outline.  Filter on this field using the
selector in the upper right corner.

Sync A check mark appears in this column if the outline is
configured to synchronize with the desktop

Desktop A name appears in this column if the outline is configured
to only synchronize with a single machine.

Size The total size of the outline in bytes.

Items The number of items in the outline.

Last modified The last time or date the outline was modified.  A time is
shown if the outline was modified today.  Otherwise, the
date is shown.

On Card A check mark appears if the outline is stored on a storage
card (CF, MS, SD).

Usage Count The number of times the outline has been opened.

Private A check mark appears in this column if the outline is
marked as private.

The view on the handheld that shows the list of outlines can be customized.  In
addition to selecting what columns are displayed, the column size and location can
be changed.

If you have installed a new outline on the device by either; beaming, import, or the
Palm Install tool, and it does not show in this view, then use the Refresh command
on the View menu to scan for the new outline.
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Tap on a column header to display a menu with options for sorting and column
selection.  Tap on the header past the last column to select a new column for display
as the last column.

Tap on the header to display a menu
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Then select a new column to display from the list of columns.

Commands available on the header menu.

Command Description

Hide Header Collapsed the header to a narrow line. This increases the space
available to display the names of outlines.

Sort Ascending Sorts the list of outline by the column tapped in ascending order.

Sort Descending Sorts the list of outline by the column tapped in descending
order.

Hide Column Hides the column that was tapped.  At least one column must
be displayed.

Show Column... Displays a menu of columns that can be displayed.

Tap on the column separator in the header and drag to change the size of the
column.

Tap and hold on an outline's category to display a menu of categories.  Select a
category from the menu to be assigned to the outline.

Tap and hold on an outline's name to display a menu of actions that can be
performed on the outline.

Tap on a selected outline's name to open the outline.  Tap on other columns of a
selected outline and the details for the outline will be displayed.
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When using a portable keyboard, the scroll keys will move the selection up and
down, and scroll the display left and right.  The Enter key will open the selected
outline.

When using a handheld with 5-way navigation buttons, like the Treo 600, press the
Option button along with one of the navigation buttons to move the focus from the list
to the category filter, or the command buttons.

4.15.2 Outline Details

A view is provided by the Palm application that shows some of the attributes of the
outline and is used for setting the outline's category.
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Setting Description

Category Select the category for this outline. The view that displays
outline names  can be filtered and sorted by category. The
Bonsai desktop application can also group outlines by
category.

Private When checked, the outline will not be visible when the
Palm OS security setting is configured to hide private
items.

Store on Storage Card Check this setting to store the outline on a storage card.
Some handhelds support more than one storage card slot
or have virtual internal storage cards. Select the
appropriate storage card from the drop list.

Synchronize with desktop Check this setting to synchronize the outline with the
desktop.

Only Synchronize with machine Check this setting to setting to only synchronize this outline
with a single desktop.  Enter the name of the desktop
machine in the following field.

The usage count is the number of times the outline has been accessed.

4.16 How Do I ... ?
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4.16.1 Create a New Outline

Tap the New button on the outline list view and enter the name for the outline.  You
can also select the category for the outline, and the initial set of categories for use
with the outline.

There are 4 options for the initial set of categories.
· Standard (Business and Personal).
· Outline - Copies the set Bonsai uses to categorize the outlines.
· To Do's - Copies the current categories from the standard To Do application
· Empty - No categories are defined.

The name given to the outline will be used for the file name on the desktop during
synchronization.

4.16.1.1 Using Another Outline

Tap and highlight the outline you use as a template. Use the Copy command from
the Outline menu to start a new outline.
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4.16.2 Delete an Outline

Deleting Both Copies of the Outline
To delete an outline, tap on the outline name, and then tap the delete button.  The
outline on the desktop will be deleted during the next synchronization.

If you are synchronizing the outline with multiple desktops, see the note in the
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multiple desktop topic.

Leaving the Outline on the Desktop
Use the Archive command to delete the outline only the Palm device.  The outline on
the desktop will be set to not synchronize.

4.16.3 Move Items to Another Outline

Use the Cut Branch - Paste Branch, or Copy Branch - Paste Branch operations to
move items from one outline to another.

4.16.4 Delete Items

To delete an item, position the caret in the item's title and use the Delete command
from the Record menu.  You can also use the Cut Branch command from the Edit
menu or the Cut Branch icon displayed on the bottom of the screen.

If you backspace (or Del) on an empty item, the item is deleted.

The last item in the outline cannot be deleted.

Note: Deleting a parent item will delete the entire branch.

4.16.4.1 Delete Completed Items

A command is available on the Options to delete all completed items from the
outline. The action cannot be reversed, so a confirmation prompt is displayed before
deleting the items.

If all the items in the outline are deleted, a new item is added to the outline.

Items in the outline with the Simple type, which does not have a completion status,
are not effect by this command.

Note: If a parent is marked complete, the entire branch will be
deleted even if some of the child items are not marked complete, or are
Simple items.



Natara Bonsai User Manual154

© 1999-2007 Natara Software, Inc.

4.16.4.2 Delete Notes

There is a Delete command on the Note menu to quickly remove a note from an
item.

4.16.5 Sort

The sort command is used to sort the items in an outline branch. The outline can be
sorted by 2 attributes, so that if items are equal on the first attribute, the second
attribute is used.  The current branch (where the insertion caret is positioned) of the
outline is sorted.

There are 2 options for the scope of the sort.
· The sort is only performed on the level of the current item
· Besides the current level, all levels below on the current branch are sorted.

When the current item is on the first level, and the second option is selected, the
entire outline is sorted.

The Sort Branch command is located on the Edit menu.
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4.16.6 Display Note Icon and other columns

Tap on the right side of the column header to display additional columns in the
outline view. Select "Show Column" from the menu. Select the Note column from the
list of available columns.
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Note: The column header can be collapsed on the handheld to increase the
room for the outline. When the header is collapsed it will appear as a
thin rectangle or line at the top of the screen (but below the title bar).
Tap on the collapsed header to expand it.

4.16.7 Search the Outlines

Bonsai supports both the global Palm OS find application and an internal find
command.

4.16.7.1 Internal Find Command

Tapping on the binocular icon starts the internal find command.  There are also Find
and Find Again commands on the View menu.

When the search text is found in the outline, the view is positioned to the item and
the text is highlighted.  Tapping the icon again will find the next occurrence of the
search string.

The internal find command only searches the current outline.  To search multiple
outlines use the global find.
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Note: The find text string is not case sensitive.

Note: The handheld application does not search the notes.  Use
the Global find to search the notes text.

4.16.7.2 Palm OS Find

The Palm OS find application searches all applications on the Palm device.  Bonsai
supports this feature and will return outlines that contain the search text.
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When you tap on one of the matches, Bonsai will display the outline and place the
caret at the search text.

Note: The Palm OS Find command does not search outlines
stored on a storage card.
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4.16.8 Jump Back from a Link

Bonsai has an option to insert link tags into linked To Do's and Events. The link tags
help to identify To Do's that are associated with a Bonsai outline.  There is also an
add-on called Back-2-Bonsai that will display additional outline context information
and provide the ability to jump back to the Bonsai outline. The link tags can be
embedded in either the title or the note attached to the To Do or Event.  Options for
the link tags are in the Settings dialog.

Double-tap on the link tag to display additional information about the outline item.
The first line shown in a bold font is the name of the outline containing the link. The
following lines provide either the full hierarchy of the linked item, or the direct parent.
Tap Close to return to the To Do or Calendar application.  Tap the Go To button to
launch the Bonsai application and display the outline.  There is an option to jump
directly to the Bonsai outline without displaying this dialog.
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4.16.8.1 Installing Back-2-Bonsai

The Back-2-Bonsai add-on is installed into the Bonsai installation directory on the
desktop by the Bonsai setup program. Use the file "Back2Bonsai.PRC" for
handhelds running Palm OS 5 . Use file "Back2BonsaiHack.PRC" for handhelds
running Palm OS 4 and earlier. The Palm OS 4 version requires a hack manager like
TealMaster from TealPoint Software.

Double-click on the PRC file to launch the Palm install tool, then click Done.  Perform
a synchronization to install the Back-2-Bonsai add-on onto your handheld.  After it is
install, configure Back-2-Bonsai.

If you are unsure of what OS your handheld is running, the version number can be
found on the Info dialog.  From the Palm application launcher screen, select the Info
command from the App menu.  Tap the Version button at the bottom of the screen.

http://www.tealpoint.com
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Do not install the Back-2-Bonsai application to a storage card.  It must be installed
into main memory.

4.16.8.2 Configuring Back-2-Bonsai

The Back-2-Bonsai add-on must be configured before it will operate. There is also an
option to display the Bonsai link context in a small dialog when the link tag is double-
tapped.

The Back-2-Bonsai version for Palm OS 5 is configured by running it from the Palm
application launcher screen. After setting the desired options, return to the launcher
by tapping the home icon.
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The Back-2-Bonsai hack will appear in the hack manager on Palm OS 4 handhelds.
Enable the hack and tap the configure button.
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4.16.9 Export an Outline

Once you have created an outline for a document and want to work on the body, you
may want to export your outline.  Bonsai provides an export command that can
format the outline either in memo or Doc format.

The Export command is found on the Outline menu of the view that lists the outline
names.  The export dialog has several settings for attributes to be included in the
memo.

4.16.9.1 To Palm DOC Format

The name of the Doc database defaults to the outline name and can be changed.
The Doc format also supports the export of the notes.
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4.16.9.2 To the Memo Application

Text from notes can also be exported to the built in memo database.  The entire note
can be exported, or make a selection to export a portion of the note.
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4.16.9.3 To Natara DayNotez

When a Bonsai outline is used as a To Do list, it's convenient to be able to file away
completed items where they can be referred to in the future.  Natara DayNotez
journal provides a great place to file the completed tasks.

Use the File in DayNotez command on the Options menu to move the information
from a completed To Do to DayNotez.  The DayNotez entry is created using the
following information:

· Item title
· The note text can be optionally included
· Category (if matching category is found)
· Completed Date (if not set, then uses current date)

The private setting and time are set from the dialog.

The item can be optionally deleted from the outline after it is added to DayNotez.
When this option is used, the entire branch will be deleted even if the option to
include the sub-item's text is not checked.
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If you want to edit the resulting DayNotez entry, check the Launch DayNotez option.
DayNotez will be placed into the edit form for the created entry as shown in the last
screen image.

Note:
The total length of the DayNotez entry is limited to 32K.  If the exported
branch exceeds this limit, it will be truncated.

4.16.9.4 To the To Do Application

An item can be used to create a To Do in the built in To Do database.  Position the
caret on the item to export.  Use the Create To Do command on the Record menu.  If
the item has a note, the note will be attached to the new To Do.  The due date and
priority are also used in creating the To Do.

An item's note can also be used to create a To Do.  Select a portion of a note and
use the Create To Do command on the Note menu.

4.16.10 Store outlines on a storage card

Bonsai can store outlines on a storage card instead of using the handheld memory.
To use this feature, open the outline details dialog and check the "Store on Storage
Card" option.
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When you close the dialog, Bonsai will automatically move the outline from main
memory onto the card.  It will create a subdirectory on the card to store the outline in.
Thereafter, anytime you work with the outline Bonsai will copy it from the card to
main memory, and copy it back to the card when you are through.

If you later return to this dialog and uncheck the option, Bonsai will remove the
outline from the storage card and store it in main memory.

Outlines stored on storage cards can be synchronized with the desktop.

4.16.11 Import Data
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4.16.11.1 To Do's

The application on the handheld has a command to import To Do's from the
standard To Do database.  The import command is under the Options menu.

Tap on the To Do's to be imported.  In import icon will be displayed next to each To
Do that will be imported.  A separate item is created in the outline for each To Do
imported.

There is an option that affects what is done with the original To Do's.  The choices
are:

· Link with To Do – An item is created that is linked to the original To Do.
Changes made to either are reflected between the applications.

· Copy – An item is created using information from the To Do, but there is no
link created between them.

· Move – An item is created using the information from the To Do, and the
original To Do is deleted.

The items are inserted into the outline following the current item.

4.16.11.2 From Other Outline Applications

An import tool is available to import BrainForestÔ outlines.  The Bonsai setup
program installed the import tool (ImportToBonsai.PRC) into the Bonsai installation
directory.  If you need to import old outlines, install the application onto your Palm
device using the Palm Install Tool.  An icon for the Bonsai import tool is added to
your application screen.



Bonsai Outliner for Palm OS 171

© 1999-2007 Natara Software, Inc.

· Tap the "Bonsai Imp" icon to run the import tool.
· Select the outline to import from the drop down list.
· Tap the Import Now button.
· A message is displayed when the import completes.
· Launch Bonsai and go to the view that lists outline names.
· Use the Refresh command on View menu to scan for the imported outline

When you are done importing, delete the import tool using the Delete common on
the App menu to free up memory on your Palm device.

4.16.12 Reuse an Outline

Bonsai has a command to clear the status for all items in an outline.  The Reset
command is located on the Outline menu on the view that shows the outline names.
The operations performed on the outline are:

· Clear all To Do check boxes
· Set percentage complete of all tasks to 0%.
· Set all dates (start, due, completed) to the 'no date' value

There is an option to not clear the date fields.



Natara Bonsai User Manual172

© 1999-2007 Natara Software, Inc.

4.16.13 Rename an Outline

Outlines can be renamed on the handheld from the list of outlines.  Select the outline
to be renamed, tap and hold to bring up the context menu.  During the next
synchronization, the outline on the desktop will be renamed.
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5 Synchronization between Windows & Palm OS

Once a new outline has been created on the Palm device or the desktop it is ready to
be synchronized.  During the first synchronization after the outline is created, the
Bonsai conduit will create a matching outline on the other platform.  During
subsequent synchronizations the conduit will synchronize changes from both outlines
into the other.

Synchronization is performed at the item attribute level.  For example, if you make a
change to the text of one item on the desktop, and check-off the same item as
completed on the Palm device, both changes will be propagated to the other
platform.

If you change the same attribute on both platforms (e.g., modify the same text) the
conduit will display a dialog box during synchronization to alert you to the conflict.

The desktop application Outline Manager window provides a list all the outlines
configured to synchronize for a given HotSync User.  Use the HotSync User
command on the File menu to switch users if you synchronize more than one
handheld at your desktop.
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5.1 New Handheld Outlines

Outlines created on the handheld will automatically be synchronized to the desktop.
The file name for the outline is taken from the outline name.  The outline is created in
the directory configured on the Synchronization tab of the Global Settings dialog.
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Removing the check on the synchronization option, located on the outline details
dialog, will disable synchronization of the outline.

Check the "Only Synchronize with Machine" option and enter a desktop machine
name to prevent the outline from synchronizing with any other machine.  The Bonsai
conduit will fill in this field with the name of the last machine the outline was
synchronized with.

5.2 New Desktop Outlines

When you save a new outline, you are given the choice to configure the outline to
synchronize. The synchronization status is shown on the status line.

If you no longer want to synchronize an outline, use the Synchronize command on
the File menu to toggle synchronization off.  You are also given the option to remove
the outline from your Palm device during the next synchronization.

If you need to move outline files, use the Move button on the Synchronization dialog.
This command will update the information Bonsai maintains regarding outlines that
are synchronized.

Outlines that are open on the desktop will be automatically saved when
synchronization starts, and reloaded when synchronization completes.  If you are
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editing an outline and have made changes that you want to discard, close without
saving before performing the synchronization.

Note:
Although it is not necessary to close open outlines during
synchronization, do not actively edit the outlines during synchronization.

5.3 With Multiple Desktops

When the Bonsai conduit recognizes that an outline last synchronized with another
desktop is being synchronized, it will automatically switch to "Handheld Overwrites
Desktop" mode if the desktop outline has not been modified.

Note: When you delete an outline, you must also delete the outline from the
second desktop.  Otherwise the second desktop will copy the outline to
the handheld during the next synchronization.

5.4 Synchronization Action

Use the HotSync Manager Custom dialog to configure the synchronization action for
the Bonsai conduit.  For normal operation, the configuration should always be set to
'Synchronize the files'.
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